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Anexo 1 - Tabela de comparação de painéis

Anexo 1 - Tabela de comparação de painéis

Tabela com as correspondências, iniciando com a ordem do InDesign CS5 e 
prosseguindo com a do QuarkXpress 8.51, alguns painéis têm correspondência a menus 
(que estão identificados a carregado).

Painéis InDesign CS5 Painéis QuarkXPress 8.5
Cor/Colour > �Cor/Colour 

Degradê/Gradient 
Amostras de Cor/Swatches

Cor/Colour

Barra de Control/Control Medidas/Measurements
Editorial > �Atribuições/Assignmnets 

Notas/Notes 
Monitorar Alterações/Track Changes

–

Efeitos/Effects Efeitos de Imagem/Picture Effects
Extensões/Extensions –
Informação/Info –
Interactividade/Interactive (Vários)/ Interactividade/Interactive
Camadas/Layers Camadas/Layers
Vínculos/Links menu Utilitários/Utilities > Utilização/Usage
Mini‑Bridge –
Object & Layout > 
      �Align/Alinhar 

Pathfinder 
Transform/Transformação

Alinhar/Align – Tem no painel Medidas/
Measurements

menu Item > Agrupar/Merge e Dividir/Slipt
Medidas/Measurements

Saída/Output >
      �Atributos/Attributes 

Visualização do nivelador/Flattener 
Preview 
Comprovação/Preflight 
Visualização de Separações/Separations 
Preview 
Predefinições de Trapping/Trap Presets/

–

–
–
menu Visualização/View > Saída para prova/

Proof Setup
Informação de ajustamento/Trap Information

Páginas/Pages Apresentação de Página/Page Layout
Traçado/Stroke Medidas/Measurements
Estilos/Styles >
      �Estilos de Células/Cell Styles 

Estilos de Caracter/Character Styles 
Estilos de Objecto/Object Styles/ 
Estilos de Parágrafo/Paragraph Styles/ 
Estilos de Tabela/Table Styles/

–
Folhas de Estilos/Style Sheets
Estilos de Item/Item Styles
Folhas de Estilos/Style Sheets
–

Texto em Contorno/Text Wrap menu Item > Contorno/RunAround
Ferramentas/Tools Primitivas/Tools

1	 Os termos são apresentados tal como surgem nas versões de linguagem portuguesa e na linguagem 
inglesa.
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Anexo 1 - Tabela de comparação de painéis

Painéis InDesign CS5 Painéis QuarkXPress 8.5
Tipo e Tabelas/Type & Tables > 
      �Caracter/Character 

Texto condicional/Conditional Text 
Referências cruzadas/Cross References 
Glifos/Glyphs 
Índice/Index 
Parágrafo/Paragraph 
Matéria/Story 
Tabela/Table

menu Estilo/Style > Caracter/Character
–
Índice/Index
Glifos/Glyphs
Listas/Lists
menu Estilo/Style > Formatos/Paragraph
menu Estilo/ Style > Formatos/Paragraph
menu Tabela/Table

Utilitários/Utilities >
      �Tarefas em Segundo Plano/Background 

Tasks 
Mesclagem de dados/Data Merge 
Rótulo de Scripts/Script Label 
Scripts 
Marcas de formatação/Tags 
Ferramenta Dicas/Tool Hints

–
Placeholders
–
menu Scripts

–

Painéis QuarkXPress 8.5 Painéis InDesign CS5
Conteúdo partilhado/Shared Content –
Informação do Perfil/Profile Information Vínculos/Links
Estilos de grelha ou quadrícula/Grid Styles –
Efeitos de Imagem/Picture Effects –
Placeholders Mesclagem de dados/Data merge

Guias/Guides
–
As guias controlam‑se como se fosse objectos, 

através do painel Transformar/Transform

PSD Import menu Objecto/Object > Opções de camada do 
objecto/Object Layer Options

Ajustar/Scale –
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Anexo 2 – Painel de medidas do QuarkXPress 8.5

Anexo 2 – Painel de medidas do QuarkXPress 8.5

A – Coordenadas em relação ao Eixo (Ponto) Zero
B – Dimensões do objecto
C – Rotação
D – Colunas
E – Opacidade da cor da caixa
F – Tonalidade da cor da caixa
G – Inversão horizontal
H – Inversão vertical

I – Entrelinha
J – Alinhamento horizontal
K – Tipo de letra
L – Corpo
M – Estilos Carregado, Itálico e Vários
N – Características OpenType
O – Percentagem de cor do texto seleccionado
P – Opacidade do texto seleccionado

1 – Clássico/Classic

C OL N
E G I K

D PF HA B J M

A – �Alinhamento vertical
B – Valor da deslocação da primeira linha
C – �Posição da primeira linha a partir da altura do 

ascendente, da maiúscula, da maiúscula + acento
D – Entrelinhamento
E – Ângulo de rotação de texto
F – Número de colunas
G – Inclinação de texto

H – Intervalo entre colunas
I – �Activar valores de defesa individuais (em relação 

aos lados da caixa)
J – �Permitir que o texto contorne o objecto de ambos 

os lados
K – �Valores de defesa do texto para a caixa (topo, base, 

esquerda e direita)

2 – Texto/Text

ECA
G I K

F H JB D

A – �Espessura de filete
B – Tipo de moldura
C – Cor e percentagem de cor do traço 
D – Cor e percentagem de cor do intervalo (para tracejado)
E – Opacidade do traço 
D – Opacidade do intervalo (para tracejado)

3 – Moldura/Frame

BA
C E

D F
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Anexo 2 – Painel de medidas do QuarkXPress 8.5

A – Activar/desactivar a opção de contorno
B – Distância entre o texto e o objecto
C – Apenas limites externos

4 – Contorno/Runaround

BA
C

A – Língua da hifenização no parágrafo activo
B – Escala horizontal ou vertical
C – Activar ligações de caracteres
D – Deslocação da base da linha
E – Tipo de letra

F – Corpo
G – Estilos Carregado, Itálico e Vários
H – Características OpenType
I – Percentagem de cor do texto seleccionado
J – Opacidade do texto seleccionado

5 – Atributos de Caracteres/Character Atributes

A F H I
C

B G JC D E

A – Recolhidos (indents) à esquerda e à direita
B – Recolhido (indent) para a primeira linha
C – Ajustar à grelha
D – Espaços anterior e posterior ao parágrafo
E – Entrelinhamento

F – Alinhamento horizontal
G – Activar capitular
H – Número de letras em capitular
I – Número de linhas afectadas pela capitular

6 – Atributos de Parágrafo/Paragraph Atributes

A
G

B

C E H ID F

7 – Espaçamento/Alinhamento/Space/Align – Com a ferramenta de texto, as funções de 
espaçamento/alinhamento não estão activas. 
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Anexo 2 – Painel de medidas do QuarkXPress 8.5

A – �Tipo de alinhamento da tab
B – Posição (valor numérico)
C – Validar/Activar

D – Caracter(es) de preenchimento
E – Alinhar por
F – Eliminar todas as tabs programadas

8 – Tabulações/Tabs
A B

D E FC

A – �Aplicar a sombra
B – Sombra a somar
C – Herdar opacidade
D – Cor e percentagem da sombra
E – Opacidade da cor da sombra
F – Ângulo
G – Distância

H – Inclinação
I – Escala da sombra
J – Sincronizar ângulo
K – Desfocagem da sombra
L – Item desactiva sombra de capitular
M – Contonar sombra de capitular

9 – Sombra de capitular/Drop Shadow
A

D F H JC E G I K MB

L

O

P

A – Coordenadas em relação ao Eixo (Ponto) Zero
B – Dimensões do objecto
C – Rotação da caixa
D – Selecção de tipo de canto e dimensão do efeito
E – Cor e tonalidade da cor da caixa
F – Opacidade da cor da caixa
G – Inversão horizontal
H – Inversão vertical
I – Escala horizontal da imagem

J – Escala vertical da imagem
K – �Distância do lado esquerdo da imagem ao lado 

esquerdo da caixa
L – �Distância entre o topo da imagem e o ao topo 

da caixa
M – Rotação da imagem dentro da caixa
N – Inclinação da imagem dentro da caixa
O – Máscara
P – Resolução efectiva da imagem

1 – Clássico/Classic – Parte das opções são semelhantes às já referidas para a caixa de texto.

C M
E G I K

D J L NF HA B

Com uma caixa de Imagem activa 
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Anexo 2 – Painel de medidas do QuarkXPress 8.5

A – Tipo
B – Defesas em relação ao texto
C – Apenas limites externos
D – Restringir ao rectângulo

E – Inverter
F – Ruído
G – Limite
H – Suavização

2 – Contorno/ Runaround – Defesa da caixa com opções de recorte.

B G
C E

A F HD

A – Escolha do tipo de recorte
B – Defesas em relação ao texto
C – Apenas limites externos
D – Restringir ao rectângulo

E – Inverter
F – Ruído
G – Limite
H – Suavização

3 – Recorte/Clipping – Recorte da imagem com opções de activação do recorte da imagem.

BA G
C E

F HD

A – Coordenadas do conjunto de itens 
seleccionados em relação ao Eixo (Ponto) Zero
B – Dimensões do conjunto de objectos 
seleccionados
C – Rotação
D – Selecção do tipo de canto e dimensão do efeito
E – Espaçamentos verticais

F – Tipo de espaçamento
G – Espaçamentos horizontais
H – Alinhamentos disponíveis
I – Referência para distribuição de objectos (itens 
extremos/página/área de trabalho)
J – Distância para espaçamento

4 – Espaçamento/Alinhamento/Space/Align – entre dois ou mais objectos seleccionados

C
E G I

D F JA B H
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Anexo 3 – Painel de controle do InDesign CS5

A – Tipo de letra
B – Estilo de letra
C – Entrelinha
D – Corpo
E – Opções para caracteres
F – Tracking
G – Kerning
H – Base de linha
I – Escala vertical
J – Inclinação
K – Escala horizontal
L – Cor dos caracteres

M – Língua
N – Estilo de caracteres
O – Alinhamento horizontal
P – Recolhidos (indents)
Q – �Linhas afectadas pela 

capitular
R – �Espaço posterior e anterior 

do parágrafo
S – Caracteres para capitular
T – Listas numeradas
U – Estilo de parágrafo
V – Hifenização (liga/desliga)

W – �Limpar alterações ao estilo 
de parágrafo

Y – �Ajuste à grelha da base de 
linha

X – Colunas
Z – Intervalo entre colunas
a – Transpor ou dividir colunas
b – Posição do cursor
c – �Aplicação rápida (Quick 

Apply)
d – �Opções da barra de controlo 

para caracteres

1 – Caracteres/Character e Parágrafos/Paragraph

c d

A B C D E F G H I J K L M N

O P Q R S T X aZ bU V W Y

A – Ponto de referência
B – Coordenadas do objecto
C – Dimensões do objecto
D – �Manter proporções entre largura e altura do 

objecto
E – Escala horizontal e vertical
F – Manter percentagem proporcional do conteúdo
G – Inclinação
H – Ângulo de rotação
I – Rotação a 90º e efeito espelho
J – Tipo de selecção de objecto

K – Cores do objecto
L – Espessura e tipo de contorno
M – Efeitos
N – Contorno de texto
O – Cantos redondos
P – Opções de ajuste
Q – Alinhamentos
R – Estilos de objectos
S – �Aplicação rápida (Quick Apply)
T – Opções da barra de controlo para objectos

2 – Objecto/Object

S T

B C D FA E I J N OG H L MK

P Q R
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Anexo 3 – Painel de controle do InDesign CS5
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Anexo 4 – Relatório do IT-Inquerer Reports

Anexo 4 – Relatório do IT-Inquerer Reports

QuarkXPress 7 vs. InDesign CS3 – Analysis of efficiency, workflow, 
workgroup support and productivity
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is report presents the results of an analysis comparing the
most important functionality aimed at productivity, creativity,
and efficiency in QuarkXPress 7 and Adobe InDesign CS3. e
analysis consists of timing results measured for identical tasks
performed in each application and of a qualitative assessment
of features that can’t be measured in time.

In particular, we tested tasks and challenges in the following
application areas:

• Document, setup, collaboration and
design consistency

• Working with layouts

• Printing and output

• Miscellaneous other tasks

e table at the end of this summary lists the results. We found
QuarkXPress to be faster in 79% of the tasks; InDesign was
faster in 21% of the tasks. However, the degree to which the
tasks were faster in either application varied and might not al-
ways be relevant to the user.

For example, most users won't notice if a task takes 9 vs. 11 sec-
onds, even though that is 18% faster. However, if that is a task
that in their particular workflow they perform all the time, the
2 seconds delay in one application does matter. Where appro-
priate we will highlight in the report which task matters most
for which type of use case.

We found that QuarkXPress 7 has better support for design de-
partments where more than one person must be able to control
and manage the layout process by offering support for Job Jack-
ets, Composition Zones and sharing colour management ele-
ments. In many areas, QuarkXPress 7 also is just faster,
supporting the creative process better by including –right
within the application– Web and Flash layouts, and the most
oen needed creative tools and effects.

InDesign CS3 is faster and offers better support in the areas of
table styling, XML, and Object Styles. e automation of long-
document functionality like automatic running headings, run-
in headers and nested styles are other examples of where
InDesign CS3 is better.

In the qualitative domain, we found users can perform many
tasks without opening extra palettes using QuarkXPress 7’s
measuring palette. QuarkXPress 7 offers the designer a large
number of graphic tools and effects, but some of these are not
as obvious as they could be in the interface.

On the negative side, the XPert Tools Pro XTensions set in
QuarkXPress 7 has palettes that do not integrate well visually
with the other interface elements in the program.

InDesign CS3 has a more aesthetically pleasing interface and
a more obvious access to its graphic tools and effects. On
the negative side, the creative tools in InDesign CS3 are oen
implemented as a link to the external applications in the
Creative Suite.

In some other areas of InDesign CS3 we were surprised to find
that the program isn’t up to the requirements of professional
prepress users. e Pantone colour library problem, covered in
the chapter on colour management comes to mind.

QuarkXPress 7 is equipped for vertical and horizontal layout
markets: print, web, Flash, mobile content, etc. Because of its
many products it must sell, Adobe is forced to deliver InDesign
CS3 without the cross-media functionality that Quark has built
inside QuarkXPress 7.

In most areas, therefore, we were not surprised to find that
QuarkXPress 7 offers the best support for professional creatives,
with the best toolset for those whose work has to be finished
by a deadline.

e next table shows where QuarkXPress 7 and InDesign CS3
respectively were faster in the timing tests. is table does not
represent qualitative assessments nor how important the time
differences were. For those assessments, please read the corre-
sponding chapters.

Executive Summary



taSk or ChallEngE: WhICh IS FaStEr? QuarkXPrESS InDESIgn

Open application, create new document with 1 text column √

Synchronise print layouts √

Preflight document √

Prepare a design for collaboration and JDF √

Set up colour management for printing on a printing press √

Set up a collaboration environment √

Synchronise and share content in a project √

Set up a table and do some basic dynamic publishing √

Find/change object attributes √

Find/Change Text immediately aer finding object √

Create page grid and ruler guides √

Cycle through objects covering each other √

Use layers to manipulate objects on pages √

Find all linked text frames and manipulate them √

Copying and pasting objects √

Navigate a spread of 5 pages √

Add chapters to long document (book file) √

Generate TOC for long document (book file) √

Create object style and apply to different objects √

Create table styling and apply to different tables √

Create Gaussian Blur on image √

Work with frames and runaround text √

Link and unlink text frames √

Create Item Marks for printer √

Create Printer Marks √

Create Impositioning for long document √

Scale page elements and prepare for flexo printing √

Exporting to PDF/x-1a:2001 √



is report represents the benchmarks conducted for a
QuarkXPress 7 and InDesign CS3 comparison analysis report.

e benchmark project was conceived and conducted to doc-
ument differences in design productivity, workflow efficiency,
workgroup support, and feature set between QuarkXPress 7
and InDesign CS3, regardless of the markets where these ap-
plications are normally used.

In most cases, an application’s efficiency can be measured by
recording the time it takes to complete a task. For example,
the time recordings in this report show that QuarkXPress 7 is
faster at many operations. In many cases, its integrated ap-
proach to layout projects offers a magnitude better efficiency
and productivity.

In addition to measuring the time it takes to perform specific
actions, an application’s efficiency must be further evaluated
using qualitative criteria. For example, the new graphics
and text engine, although long overdue, put QuarkXPress 7
back on the same on-screen representation quality level as
InDesign CS3.

roughout the report, the reader will find observations and
considerations that will clarify most of the qualitative differ-
ences between InDesign CS3 and QuarkXPress 7 — and far
more elaborate than the above statements, we might add.

mEthoDology ovErvIEW

For this report, QuarkXPress 7 was installed with the free
Quark XPert Tools Pro XTensions set turned on. Furthermore,
to allow for a balanced comparison between features, Quark
Interactive Designer and Quark Print Collection were used in
relevant test areas. InDesign CS3 was installed as part of the
Design Premium version of Creative Suite 3. Both applications
were installed without third-party plug-ins or XTensions.

e benchmarks in this report show the time it takes for a lay-
out designer to perform specific tasks. We deliberately did not
select to compare the time it takes to complete a project, as dif-
ferent people will come to the same results using different
methods — there is no commonly supported best practice for
creating a complete layout.

Task measurements are more accurate and therefore lend them-
selves well for quantitative analysis. We measured the time it
took to complete each task in QuarkXPress 7 and InDesign
CS3, and the external applications necessary to get the desired
result. When the time difference exceeded three minutes, we
stopped the test and noted the results.

In many areas, we also included a qualitative assessment of the
application’s support for completing a task.

Measurements are given in minutes : seconds : hundreds
of seconds.

IN ALL CHARTS, SHORTER BARS ARE BETTER.

tEStIng ConFIguratIon

Intel Mac Pro dual 3GHz Xeon

ATI XT1900 X with 512 MB RAM.

2GB RAM.

250GB system disk.

750GB data disk.

QuarkXPress 7.2 with Quark XPert Tools ProXTension Set,
Quark Print Collection, and Quark Interactive Designer installed.

InDesign CS3 with no extra plug-ins installed, and installed as
part of the Premium Design Creative Suite 3. is soware
suite includes Adobe Illustrator CS3, Dreamweaver CS3, Adobe
Bridge and Version Cue v.2, and Photoshop CS3.

�

Introduction



TaSk: open application, create new
document in 1 text column

�

PrElImInary ConSIDEratIonS

QuarkXPress 7 uses Projects and Layout spaces to deliver
multi-channel design, and content sharing and repurposing.
InDesign CS3 employs a single document model. In order to
test launch times, only the creation of a print document was
tested as this is the only way to properly compare the perform-
ance of both applications in this context.

InDesign CS3 has the Plug-In Configuration feature to turn off
plug-ins that are seldom used. To speed up startup perform-
ance, QuarkXPress 7 supports XTensions Sets. ese sets allow
the user to activate exactly those XTensions that are of use to
him for the completion of specific projects and tasks. e XTen-
sions Manager ensures that all related XTensions are turned off
or on together, just as with InDesign CS3. On opening
QuarkXPress 7, there are two ways you can create a new doc-
ument. e first is by using QuarkXPress’s default, built-in File
> New dialogue. is dialogue works the same as the InDesign
CS3 dialogue in that it enables the user to create an empty new
project. e time to populate the project with text boxes is
shied to a later phase in the workflow, i.e. aer the document
has been created.

However, in QuarkXPress 7, the user can also select to create a
new document using the XPert PageSets XTension. When a
document is created using the XPert PageSets methodology, a
page-wide text box can be created instantly. is text box —
that is linked from one page to another— appears on all pages
of the document.

is functionality has its sibling in InDesign CS3 by checking
the option “Create Master Text Frame” in the Create New Doc-
ument dialogue, but this creates an empty page with margins
set up and a text box created on the Master page. is text box
is locked, and can only be used to type text in by unlock-

ing it (Command-Shi-click on a Mac). When adding text by
typing directly in InDesign CS3, all text frames still have to be
linked manually aer unlocking this text box. Text boxes also
have to be linked from page to page explicitly. InDesign CS3
does support the linking to external text.

QuarkXPress 7 also allows text import with automatic text flow,
using the XPert PageSets XTension. XPert PageSets is limited
to print layouts only. In order to create a web page or Flash lay-
out, the user must click on the QuarkXPress icon in the XPert
PageSets dialogue and will be shown the default QuarkXPress
7 File/New dialogue where he can select other layout types.
XPert PageSets can be saved, enabling users to recall margin
settings, layouts, page orientation, whether an automatic text
box must be created, etc. PageSets resemble templates, but they
don’t occupy extra space in the file system, and they don’t re-
quire an elaborate setup. In InDesign CS3 users can save doc-
ument settings as “preset”, although these do not contain the
settings for section prefix, number and number format.

bEnChmark

Test Object and Method – e benchmark measured the time
it takes to create the new document so a user can start adding
content. In QuarkXPress, this encompassed creating a new file
with the automatically added text frame holding the text cursoras
soon as the file is created. In InDesign CS3, this entailed creat-
ing a new file with Master Text Frame checked, and then un-
locking the text box to get the user started.

benchmark results

1. Document Setup,
Collaboration and Design Consistency

Create new Document with text Frame



ChallEngE: prepare a design for
collaboration and JDF

Document Setup, Collaboration and Design Consistency
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PrElImInary ConSIDEratIonS

QuarkXPress 7 offers a built-in digital metaphor for the job
jacket manila folder that in analogue times would accompany
a print job to hold the specifications of the job, each piece in
the print job with a job ticket attached to it, and the instruc-
tions for the next step in the process. e QuarkXPress 7 Job
Jacket/Ticket system is based on JDF and XML.

QuarkXPress 7’s Job Jacket system enables workgroup collab-
oration in that it provides for propagation of changes made by
one user to the styles and specifications in the Job Jacket of
other users (when the Job Jacket is Shared).

InDesign CS3 does not have Job Jackets or Job Tickets.
InDesign CS3 depends on Adobe Acrobat for preflighting and
JDF capabilities. ese kick in when Acrobat launches as a re-
sult of exporting a document from InDesign CS3 to PDF. e
user must then create the JDF file attachment.

In general terms, the Job Jacket / Job Ticket system in
QuarkXPress 7 adds to the time it takes to prepare the layout,
but decreases the error risk as the project progresses. Or shown
in a simplified graph:

QuarkXPress 7 Job Jackets Graphical Representation
of Design Consistency and Pre�ighting

Risk of
Inconsistency
and Cost to
Solve Errors

Time from project start to end
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QuarkXPress 7 Job Jackets graphical representation of Design Consistency and Preflighting

InDesign CS3 Graphical Representation
of Design Consistency and Pre�ighting

Risk of
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and Cost to
Solve Errors

Time from project start to end
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InDesign CS3 graphical representation of Design Consistency and Preflighting

e lack of a Job Jacket / Job Ticket system or any other job
tracking system in InDesign CS3 takes less time when setting
up the layout, but increases the risk of errors as the project pro-
gresses, shown in this simplified graph:



Document Setup, Collaboration and Design Consistency

�

PrEFlIghtIng

Preflighting should happen as early as possible in the workflow
as this is the only way to avoid the high costs associated with
having to repair errors in the output file. Note also that some er-
rors cannot be repaired at output time, forcing the printer to
send back the file to the designer, costing both money and time.

is being said, InDesign CS3 has no preflighting functional-
ity other than a short checklist to make sure the designer has
enclosed the most obvious elements in his/her design. e next
level of functionality —and the one InDesign CS3 relies on—
is the preflighting functionality offered by Adobe Acr0bat 8 Pro.

e preflighting functionality in Acrobat 8 Pro kicks in
late in the workflow, i.e. at the output stage. If an error is de-
tected, the source file must be corrected, re-exported to PDF,

and run through Acrobat’s preflighting engine again. To pre-
flight early in the workflow, designers using InDesign must buy
a Markzware FlightCheck Studio, FlightCheck Pro, or
equivalent license.

e preflighting functionality offered by Quark Job Jackets en-
ables users to preflight early in the design process, and based on
rules established in the Job Jacket and Job Ticket attached to
the project file. As Job Jackets can be distributed alongside the
layout to other designers, and as layouts themselves can be syn-
chronised across workstations, the preflighting rules are guar-
anteed to be the same across multiple designers. e Job Jacket
being included with the project, there is also no risk for a de-
signer not having received the preflight rules in the first place.
A disadvantage of Quark Job Jackets is the learning curve which
is quite steep.

application general capabilities in terms of preflighting

QuarkXPress 7 Full preflighting possible with Job Jackets - user or admin must create rules themselves -
fully customisable - early in the workflow

Adobe Acrobat 8 Pro Full preflighting for PDF - engine based on callas’ preflighting technology - presets avail-
able - late in the workflow

Markzware FlightCheck Pro 6 Full preflighting for various file formats incl. QuarkXPress 7 and InDesign CS3 - many
presets available - 489 checks possible - fully customisable - early in the workflow

InDesign CS3 No preflighting except the most basic checks - early in the workflow

bEnChmark

For this task, we tested the creation of a consistent design on
two levels:

• e printed design had to comply with specific set-
tings required by the printing process (preflighting)
and these settings had to be repeatable from one
project to another and from one user to the next

• e printed design had to fit in with a JDF workflow.

observations

Risk Assessment – We cannot properly test the differences in
risk between QuarkXPress 7 and InDesign CS3 as it will de-
pend on the size and complexity of a project. However, we can
test the time it takes to synchronise projects with and without
a pre-defined job description / instruction set. We can also test
the preflighting operation with Job Jackets and without Job
Jackets –the latter will require an additional preflighting appli-
cation. We can use Adobe Acrobat for this purpose, but this ap-
plication does not offer the same granular controls that are
possible with the rules a user can set up in QuarkXPress 7’s Job
Jackets. erefore, in our test we chose Markzware FlightCheck
Professional 6 as the external preflighting application.

Sharing Rules – To test for repeatable preflighting functional-
ity, users must be able to save preflighting rules into sets and
distribute these to others.

In QuarkXPress 7 this can be done from within the application,
saving Job Jackets for different layouts and projects, creating
Job Jacket templates, and ultimately by synchronising layouts.

To create a test set that maintains comparability to InDesign
CS3, only limited synchronisation between print layouts could
be tested. QuarkXPress 7 supports synchronising stylesheets,
H&Js, output settings and virtually everything else in a docu-
ment without requiring the user to set up a template for this
process only.

InDesign CS3 does not support synchronisation of stylesheets,
output settings, H&Js, etc., but users can save H&Js and other
elements as part of a stylesheet, save the stylesheets to an ex-
ternal settings file and then load these in the other document.

Output settings in QuarkXPress 7 can be saved on a layout
level, meaning each layout can have its own settings. InDesign
CS3 output settings can be synchronised on an application level
only by changing the corresponding Preferences.

JDF Setup – InDesign CS3 has no JDF functionality of its own.
It relies on the presence of Adobe Acrobat for the user to cre-
ate a JDF file. Hence, JDF capability is initiated only aer ex-
porting the layout to PDF.
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Test Objects and Method To test the time it takes to set up a
JDF workflow and a preflighting set, the benchmark for this
task was split up in three parts:

• Synchronise 2 projects so they match pre-defined rules

• Preflight the project against the rules set forth in the
Job Jacket or the corresponding preflighting ruleset

• Set up the JDF workflow.

e creation of the Job Jacket for the test was done using the
fastest method, i.e. by creating a layout and deriving the Job
Jacket / Job Ticket from the project settings. is does not add
preflighting rules, which the user has to do once the Job Jacket
/ Job Ticket has been created. To maintain comparibility be-
tween QuarkXPress and InDesign, it was assumed that syn-
chronisation could also mean to create a new document from
an existing template. When creating a new document from a
template in InDesign CS3 by using the New > From Template
item in the File menu, the application will first open the Adobe
Bridge program.

For the test, the user selected the File > Open menu item and
then selected the template to avoid this from happening. is
method of creating new documents is counter-intuitive, and new
users may find themselves losing time by creating a new docu-
ment explicitly from a template, until they have familiarised
themselves with the application. In order to synchronise print
layouts, the built-in synchronisation capabilities of
QuarkXPress 7 were used, while in InDesign CS3 the corre-
sponding styles, H&Js, etc. were saved into stylesheets and these
were loaded in the second layout.

To preflight the test document against PDF/X1 requirements,
the required rules were set up in the Job Jacket. is took six
and a half minutes. e Job Jacket / Job Ticket was saved for
further usage with the test document. In order to set up rules
comparable to those defined with the Job Jacket / Job Ticket in
QuarkXPress 7, the same Paragraph, Character, Table, and Ob-
ject Styles were used in the InDesign CS3 document. is doc-
ument was then saved as a template.

e JDF workflow with InDesign CS3 comes down
to this:

• User selects external JDF specification file when cre-
ating the PDF

• Acrobat is launched, and reports on errors

• User must manually compare original file to the re-
port, and changes must be made

• PDF must be re-created and the whole process reiter-
ated until user “gets it right”.

NOTE: non-PDF files such as Postscript or PPML files cannot
be run through this process.

e workflow with QuarkXPress 7 comes down to this:

• User creates a Job Jacket with JDF specifications in
place (most JDF specified fields are available) before
creating the print layout

• User preflights layout in QuarkXPress against Job
Jacket Rules and makes changes when required

• e final document is exported from QuarkXPress to
PDF with the option checked to create the JDF file as
part of the PDF output.

1�

benchmark result 1

Synchronising layouts

benchmark result 2
Preflight document

benchmark result 3
JDF Definition
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PrElImInary ConSIDEratIonS

Colour management is indispensable for colour accuracy in the
end-result. Colour management relies on a system that was de-
veloped by the International Color Consortium (ICC) and is
based on the use of a Colour Management Module, colour de-
scriptions of workspaces and devices (ICC profile), and a Pro-
file Connection Space (PCS) for converting colours from one
device to another. Every modern digital device and soware
that is aimed at creative professionals must and will support
colour management.

A colour management system should be implemented in such
a way that it allows for uniform colour management across ap-
plications used by the same user (vertical workflow) and across
users in the workflow (horizontal workflow). It should contain
RGB and CMYK workspaces, support Pantone and other spot
and named colours and colour libraries.

vertical Workflow
InDesign CS3 being part of the Adobe Creative Suite has full
support for a vertical colour management workflow. However,
sharing a colour management setup requires all receivers to use
Adobe Creative Suite products as well since the only way to
share a colour management setup is by copying the binary CSF
file that describes it.

For vertical colour workflow, QuarkXPress 7 relies on a user or
colour expert setting up the applications used in the workflow
so the colour management specifications are identical through-
out. For this purpose, QuarkXPress 7 can export a colour man-
agement setup as a simple XML file which can be read by a
human operator.

horizontal Workflow
QuarkXPress 7 supports sharing a colour management setup
by exporting the setup to an XML file which fits into a JDF
workflow. e easiest way for users to share colour manage-
ment setups in QuarkXPress 7 is by using Job Jackets, but even
if those are not available, the colour management setup de-
scription can be exported to a file that can be imported in a re-
mote copy of QuarkXPress 7.

If the remote user doesn’t use QuarkXPress 7, the colour setup
file can be opened in any text editor and the colour setup can
be read directly from the file by the human operator. In both
applications’ sharing concept, the remote user is required
to have a copy of the profiles used in the description file on
his/her system.

QuarkXPress 7 shows the user the profiles used for every object
in a project in a list that can be viewed on a per-profile basis.

InDesign CS3 shows the image characteristics on a selected-
image basis or in its preflight report.

Colour management risks
In InDesign CS3 the user can convert any image to any profile,
and can assign profiles to images. e capability to do so can-
not be turned off. In colour managed environments, to allow pro-
files to be assigned to images and convert images to other profiles,
is potentially dangerous. A layout designer who has only lim-
ited knowledge of colour management may decide an image’s
colours are off —judging them by what he sees on his moni-
tor— and therefore change the profile to make the image look
better on-screen. is in turn may break the colour manage-
ment setup as it was developed by a colour management expert
for the environment in which the designer is working.

Furthermore, the ability to synchronise across applications can
actually increase the risk of bad colour management. If a layout
designer has InDesign CS3, Photoshop CS3 and Illustrator CS3
all synchronised for a SWOP colour workflow but the client
wants to print to FOGRA standards, the designer will have to
switch colour management settings for the three applications
at once.

is can be done through Adobe Bridge. However, when next
time, the designer must create a layout in InDesign that must
comply with some seldom used Japanese standard, he will have
to remember switching the settings for all applications again
—or risk to forget that he disabled the colour setting synchroni-
sation.

Also note that the changes the user makes in Adobe Bridge do
not propagate to other workstations.

QuarkXPress 7 has multiple colour output setups for different
output destinations. If an ad is to be placed in ten different pub-
lications, the designer can preview how the ad will look in the
ten different colour setups with a simple menu switch.

In Adobe’s Creative Suite, to preview this ad in all the different
colour setups, would involve switching the colour setup of
InDesign as a whole. If the designer wants to avoid the risk of
making errors across Creative Suite —as Adobe seems to ad-
vise— the colour setup should be changed for every different
publication the ad will appear in, in Adobe Bridge.

If the designer receives an InDesign document from the client
—e.g. a dra— and that document has been saved to FOGRA
standards, the risk of subsequent edits in illustrations and im-
ages being done with the SWOP workflow turned on instead
of the FOGRA workflow increases, as there are no alerts that
will point the designer to the colour management synchroni-
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sation now being broken. In fact, if the designer never starts
Bridge in Control Centre mode, he will never see the broken syn-
chronisation icon at all.

In QuarkXPress 7, per-image colour management is turned
off by default. e user can turn it on by checking an option
in the Preferences. However, turning on an option in prefer-
ences has a higher “psychological barrier” than selecting an
item from a readily available menu. With QuarkXPress 7, Job
Jackets can have a different colour workflow pre-set for every
different client (or even for every different job). If the client de-
livers the Job Jacket to the designer, the colour workflow will
be as required regardless of what the designer sets in Photo-
shop or Illustrator.

To have the same functionality in the Adobe concept, the de-
signer will have to create external colour files and store them in
Bridge, where he must not forget to “activate” them in order to
assure correct colour management. QuarkXPress 7 therefore
keeps the risk of broken colour management as small as possi-
ble, and supports colour management better and more strictly
than InDesign CS3, despite the latter’s capability to
‘synchronize’ colour settings across the applications in the Cre-
ative Suite.

Specific Colour Management Problem in InDesign CS3 —
During tests, a serious colour-related problem popped up in
InDesign CS3. With InDesign CS3, there is an issue with the
conversion of Pantone colours to CMYK.

While both QuarkXPress 7 and InDesign CS3 have Pantone
Bridge Libraries, QuarkXPress utilizes the conversion within
the application. For example, Reflex Blue Solid Coated in

QuarkXPress 7, converted to CMYK in the colour palette will
be 100C 82M 0Y 2K. is is the equivalent to Pantone Bridge
Reflex Blue PC. In InDesign CS3, the converted colour into
CMYK results in 100C 73M 0Y 2K.

You must then select the Pantone Bridge Reference Blue PC
from the Library and that will only then give you the "correct"
colour. is is far from efficient, especially considering that in
prepress, users oen convert designers’ PMS colours to CMYK
on the fly.

bEnChmark

e benchmark presented here measures the time to change a
colour workspace from one space to another, and then propa-
gate this change to other users.

observations
In both applications’ colour management setup, there is an
intra-user (horizontal workflow) synchronization capability. In
InDesign CS3, this capability can only be shared with other
users if they also use the Creative Suite, while QuarkXPress 7
delivers synchronization across users without the need to also
be using a copy of QuarkXPress.

test objects and methods — Practically speaking, we
measured the time it takes to change the RGB-workspace pro-
file, save this as a new colour setup and make sure all users
could benefit from it by using Creative Suite’s synchronisation
feature and QuarkXPress 7’s Export feature.

benchmark results

NOTE: e large difference in time is explained by CS3’s syn-
chronization system. is relies on the user setting the colour
settings correctly in at least InDesign aer which a trip to
Adobe Bridge is necessary, because Bridge is only used to prop-
agate the settings across all CS3 applications.

Synchronise rgb workspaces
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ChallEngE: share content in a
collaboration environment

PrElImInary ConSIDEratIonS

InDesign CS3 has a direct link to InCopy from the Edit menu.
InCopy is Adobe’s editorial text editor, and is not part of any
Creative Suite offering. A rough system for sharing page ele-
ments such as text and picture frames with other designers is
InDesign CS3’s support for a feature called “Snippets”. InDesign
CS3 also supports placing InDesign documents inside other
InDesign documents. e link between the original and the
placed copy is maintained through the Links palette.

Snippets are page elements dragged off a layout to the desktop
and renamed in the file system with an extension of “.inds”.
Snippets can hold anything a user wants to drag off a page,
but their main purpose is to make the element available for
later use again. Snippets can be shared, but there is no live

connection between a snippet and the original layout from
which it was dragged. If the original changes, a new Snippet
must be dragged off the layout to the desktop or Adobe
Bridge. is can quickly lead to having a massive amount of
snippets of which it is no longer clear whether they contain up-
to-date information.

is disadvantage of Snippets is taken care of by InDesign CS3’s
new capability to place another InDesign CS3 document inside
an InDesign CS3 layout. Placing documents in other docu-
ments pre-supposes the creation or existence of an entirely new
InDesign layout.

e new feature is not an equivalent of Quark’s component-
level sharing as in QuarkXPress 7, a Composition Zone can be
created from an element on an existing page.

For simple sharing purposes, InDesign CS3 comes with a story
link feature that works through Adobe Bridge. is system al-
lows users to set up a very small editorial workflow system (typ-
ically up to 5 people maximum) with basic workflow tracking
capabilities. is system presumes the presence of an InCopy li-
cense for each editor.

Additionally, InDesign CS3 has a built-in story editor, which
serves to speed up text entry in text boxes, as the screen refresh
of text being entered directly in the layout window of the ap-
plication can be very slow, especially with long documents.

QuarkXPress 7 integrates with QuarkCopyDesk 7, which
Quark says it will release in the summer of 2007. QuarkCopy-
Desk is the (pre-existing) equivalent of Adobe InCopy. Quark-
CopyDesk is suitable for smaller environments. For larger
environments, Quark develops Quark Publishing System
(QPS), which it says will also be upgraded in summer 2007 to

integrate with QuarkXPress 7. Both InDesign CS3 and
QuarkXPress 7 can be integrated with third-party workflow
systems such as SAXoTECH, Miles33 (QuarkXPress 7 only),
K4 (InDesign CS3 only) and ATEX.

Design Departments vs. Individual
Designers
InDesign CS3 does not have a system for collaborating on a
layout with multiple designers but has the capability to place
InDesign documents within InDesign documents. However,
users who want to share an element off an existing page need
to create a whole new document in order to get others to
place the element into their layouts. To update placed docu-
ments, users must update each instance of them through the
Links palette.

QuarkXPress 7 has no snippet feature, but comes with Com-
position Zones, a sharing system that enables users to share de-
sign content with others. Composition Zones also allow for a
basic editorial workflow, without tracking capabilities.

In the QuarkXPress 7 Composition Zones concept, a designer
can either set up a layout that is made up entirely out of Com-
position Zones, or have a layout from which he/she sends some
elements to other designers to speed up the work.

e Composition Zones feature allows users to repurpose al-
ready existing content — used in this context, Composition
Zones resemble Snippets with the added benefit of maintaining
a live link between the Composition Zone and the original lay-
out element.

e live link resembles InDesign CS3’s placing documents
inside other documents, but with the added capability of shar-
ing only part of a layout instead of requiring the creation
of a complete document. e Quark Compostion Zones sys-
tem therefore allows for a better control and management of
shared content.

Example of Composition Zone vs. Placing Document —
e Composition Zones and Placed documents features can
be used to place and update advertisements that are to appear
in multiple projects and locations in various layouts. Since
many projects and layouts can use one Composition Zone, the
same advertisement can be added quickly to different projects
and layouts.

As soon as the ad changes, only the Composition Zone has to
be changed — the update will automatically propagate through-
out all linked projects and layouts.
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e Placed document allows the same basic functionality,
but when the ad changes, each instance of the Placed document
in each location in each layout must be updated. is not only
takes more time, but also increases the risk of overlooking
an ad.

Composition Zones also allow different users to work on dif-
ferent elements of the same layout. e idea here is that an Art
Director or a designer decides to delegate some of his work to
others. He/she can do so by creating a Composition Zone with
special characteristics, called an External Composition Layout.
ese Composition Zones are distributed to other users who
can edit the Zone’s content. As soon as the External Composi-
tion Zones are saved into the project folder, the project is auto-
matically updated with the Zone’s design and content.

To get the same functionality in InDesign CS3, users must buy
a third-party editorial workflow and ad management system
that may be installed as a plug-in to the application.

QuarkXPress 7 Composition Zones must therefore be appre-
ciated as a unique attempt to deliver collaboration functional-
ity right from within the layout application. To manage the
collaboration features in QuarkXPress 7, the user has a Col-
laboration Setup dialogue window at his/her disposal. is
Setup dialogue window offers access to all of QuarkXPress 7’s
collaboration features, including:

• Job Jackets

• Linked Layouts

• Shared Layouts

• Synchronized Content (text and pictures)

• e Update Scheme

e dialogue window gives users a basic tracking system of all
shared items and the sharing method that pertain to the
currently opened project. Users can chose to update their pro-
ject’s shared content by selecting one of three schemes in the
Update tab.

InDesign CS3 users who want to collaborate must
step-up to at least a basic editorial or ad management system.
Design collaboration functionality is absent from InDesign
CS3. e application is aimed at individual designers and —
with the LiveEdit plug-in that comes with Adobe InCopy in-
stalled— very small workgroups of under 5 people, rather than
users working in design departments.

From the above, it will be clear that the collaboration func-
tionality in QuarkXPress 7 could not be measured in relation to
an InDesign equivalent, except for the content re-purposing
part (non-editable) of Composition Zones functionality.

bEnChmark

is test measures the productivity of the “snippet concept”
in both QuarkXPress 7 Composition Zones form and in
InDesign CS.

test objects and methods — a Composition Zone was
created in QuarkXPress 7 and shared with other projects. In
InDesign CS3, a document was created containing the same el-
ement which the Quark Composition Zones holds. at doc-
ument was placed inside the target document in InDesign CS3.

benchmark results

Sharing Design Elements
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ChallEngE: synchronise and share
content across media

PrElImInary ConSIDEratIonS

QuarkXPress 7 is based on projects. A project can contain
printed matter in a variety of sizes and formats, web pages, and
Flash content (with the optional Quark Interactive Designer
turned on). InDesign CS3 is based on layout documents. Each
different size or format document requires a new file.

InDesign CS3 has basic XHTML export capabilities and relies
on Dreamweaver CS3 to further design the web page.
Dreamweaver CS3 comes as part of the Premium version of
Creative Suite 3. QuarkXPress has supported basic XHTML
since version 5.

In QuarkXPress 7, users can select to have their content from
one layout — e.g. a printed booklet — synchronise with other
layouts such as web pages. To this effect, a Shared Content
palette is available, containing all the shared frames, text, pic-
tures, and Composition Zones. Once created, the shared con-
tent can be dragged from the palette into the other layouts.
Aer this, synchronisation happens automatically.

A second method of sharing content between media formats is
by using the split window feature of QuarkXPress 7. Using the
split window with a print document in one half and a web or
Flash document in the other, a user can quickly drag
elements from one window into the other. By doing so, the user
will for example automatically adjust images for web usage
if the drag is from a high-resolution document to a web-pur-
pose document.

NOTE: Synchronisation can happen between different formats,
but also between identical formats in QuarkXPress 7. As an ex-
ample, an advertisement that has to appear in four different
sizes with each one having the same text or image, can be syn-
chronised in a print document. When the size needs to
be changed, the adjustment will have to be performed only once
instead of four times.

bEnChmark

A test was set up in which a formatted XHTML page was ex-
ported from an existing layout.

observations
Since Adobe has a special Creative Suite bundle for Web pub-
lishers focussed on the efficiency of coding for the Web, we
measured the time and steps necessary to synchronize the same
type of printed layout (frame of styled text with an image
below) with a web page in QuarkXPress 7 and in Creative Suite
3, using InDesign CS3 as the layout foundation for-
Dreamweaver CS3 to further build the web design.

For InDesign CS3, the benchmark shows the time it took until
Dreamweaver CS3 was launched and ready to accept com-
mands. Building the CSS to obtain a similar result as the
QuarkXPress 7 page in Dreamweaver took additional time (4
minutes to be exact).

In order for the reader of this report to fully understand how
different the Web support of both applications is, we have taken
a screenshot of the same page design as it was exported into
XHTML in QuarkXPress 7 and InDesign CS3. e
QuarkXPress 7 synchronization resulted in a XHTML file with
clean code and the following result:

e InDesign CS3 synchronisation resulted in a XHTML file
with clean code, but with the following result aer having im-
ported it in Dreamweaver CS3:
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From these screenshots, it is apparent that InDesign CS3 ex-
ports basic code which needs to be heavily edited in
Dreamweaver CS3 to obtain the same results as with
QuarkXPress 7’s synchronisation feature. Even a simple page
design needs an additional editing round in Dreamweaver CS3
to get a presentable result.

QuarkXPress 7’s web layout capabilities are effective for simple
to medium-complex page designs. An extra editing round in a
web editor is unnecessary. Only when the design becomes more
complex, does QuarkXPress 7’s web layout functionality fall
short. Even then, a user can import QuarkXPress 7’s XHTML
result in Dreamweaver CS3 to fine-tune the result further, and
save time because a good deal of the styling of the page has been
done already.

test objects and methods — e test measured the time
necessary to build a web page from a pre-existing simple print
design in QuarkXPress 7, using its Web layout capabilities, and
in InDesign CS3 by exporting the same layout to XHTML for
Dreamweaver CS3.

benchmark results

Benchmark Results

1�

Synchronising Content
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PrElImInary obSErvatIonS

Both QuarkXPress 7 and InDesign CS3 have elaborate support
for tables. InDesign CS3 offers designers a fast way of setting up
a table, complete with formatting rows and columns, but there
is no support for decomposing a table into its elements with the
formatting preserved aer decomposition. Also, users can’t se-
lect how text will flow in table cells. InDesign CS3 does have
table styles, which make formatting tables in the same style a
fast operation (See “Styling Items”) .

In QuarkXPress 7, a table can be decomposed into its elements
(cells) with all formatting remaining intact on a per-cell basis.
Users can also set up a table so that it will flow text between
cells in a pre-defined way. is can be set up on the table level,
but also manually by dragging linking lines between random
cells and even between the table cells and external text, e.g. text
on a path. Each table has to be formatted individually.

Both applications support basic dynamic publishing in the
form of the capability to link to Excel spreadsheet data. When
the Excel data changes, the tables in QuarkXPress and InDesign
CS3 can be updated by using the Usage dialogue and Link
palette respectively. QuarkXPress 7 supports linking to a
spreadsheet on a per-cell basis, which InDesign CS3 does not.

Both applications will keep the data even when the original
Excel table has become corrupt, or has moved to a different lo-
cation in the file system (at which point the link will be broken
in both applications, unless the user re-establishes the link
through a dialogue box).

An additional feature in QuarkXPress 7 is the capability to link
to Excel charts and graphs. e same live link can be main-
tained between QuarkXPress 7 and Excel, so that, when the
data in Excel changes and the chart gets updated, the chart in
the QuarkXPress 7 layout can be updated as well.

is functionality is not available in InDesign CS3, where a user
can only place a chart into a layout by first saving the chart as a
static picture. In QuarkXPress 7, the chart does not even need
to be saved as a new worksheet; embedded charts on work-
sheets with data tables work just as good.

InDesign CS3 has table styles which speed up the formatting
of a whole table considerably. QuarkXPress 7 has no globalised
table formatting, but allows formatting on a per-cell basis,
which is harder to do in InDesign CS3.

bEnChmark

e test shows the time it takes to import a live data set from
Excel in QuarkXPress 7 and InDesign CS3.

observations
From the above, it will be clear that there is little sense in tim-
ing the placement of live charts in QuarkXPress 7 and InDesign
CS3. However, this is not necessarily so with regards to tables.
In InDesign CS3, importing live links to Excel is a Preference
that is turned off by default — the trip to the Preferences dia-
logue was not taken into account in the diagram.

benchmark results

2. Working With layouts

using table to Excel data
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TaSk: find/change object
attributes & text

PrElImInary obSErvatIonS

InDesign CS3 has a very powerful find/change feature, allow-
ing users to find text, text attributes, objects, and patterns.
InDesign CS3’s Find/Change system can make use of Grep (a
pattern-matching system familiar to Unix users, but compli-
cated to learn). QuarkXPress 7 has no Grep capabilities but
comes with XPert FindChange, a totally GUI-oriented
Find/Change palette. XPert Find/Change offers users the pos-
sibility to find objects, pictures, and text attributes using check-
boxes and drop-down menus.

e Grep implementation in InDesign CS3 enables the user to
build expressions that will search for text only. Consequently,
some criteria cannot be expressed using Grep in InDesign CS3.
For example, a user cannot search for an object in InDesign
CS3 by describing where on the page it is positioned. Only the
object style characteristics can be searched for. In QuarkXPress
7, using XPert FindChange, a user can search for object char-
acteristics, positioning, location, etc, and this for each type of
object (text box, picture box, frame, text characteristics, etc) in-
dividually.

bEnChmark

e test measures the time it takes to find an object and then
immediately aerwards, some text, in a 100-page document.

observations
Although QuarkXPress 7’s Find/Change looks less powerful
because it lacks Grep support, the test showed it actually suc-
ceeded in finding a specific coloured frame much faster than
InDesign CS3. With InDesign CS3 the test not only took longer
to set up, but there also was no match for the search criteria en-
tered.

e text search gave different results. Here, InDesign CS3’s in-
tegrated Find/Change dialogue paid off in terms of speed. To
find text in QuarkXPress 7, the user must first open another di-
alogue which slows down the search process if a query is per-
formed for an object first, followed by a query for content
immediately aerwards.

test objects and methods — e object was a frame
coloured with a black to white gradient at a zero degrees angle.
e test failed in InDesign CS3, which could not find the frame
at all. Aer three attempts, the test was abandoned and the
chronometer stopped. Immediately aer this task, the stop-
watch was started again to time searching for textual content.

benchmark results
Find / Change
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TaSk: create page grid and
ruler guides

InDesign CS3 has basic guides and grid functionality. It allows
users to create and adjust a page, baseline and document grid,
and ruler guides by dragging guides from the rulers onto the
page spread or the page. A second method of setting up guides
is by selecting the appropriate menu item and setting the guides
in a dialogue window as required. Guides can be coloured ac-
cording to the Preferences set application-wide. Multiple guides
can be selected, moved, copied, and pasted on different layers.

QuarkXPress 7’s XPert Guides enables users to set up page
grids, guides, bleed and safety grids, and guides from a frame
on the page —all in the palette. Colours of guides can be set up
per page, per type of guides, per project, per layout, and per
spread. Guides can be saved as a set, exported, and re-used in
other projects and layouts. XPert Guides can be set up as ver-
tical only, horizontal only while the dialogue window offers
total control over the guide type, colour, starting and end point,
visibility, etc.

bEnChmark

Because of the limited capabilities in InDesign CS3 and the
need to test this feature with comparable results, a simple page
grid was created in InDesign CS3 using the document grid and
guides, and subsequently the same was done in QuarkXPress 7.
is page grid was selected to propagate across all 50 pages of
the test layout in QuarkXPress 7. InDesign CS3 presumed the
grid must be shown on all pages and spreads.

benchmark results Page grid
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TaSk: use layers and manipulate
objects on pages

InDesign CS3 and QuarkXPress 7 both come with a system of
layers that can be used to stack content in separate layers. An
example of the use of layers is that it allows for different lan-
guages to be quickly separated at printing time. However,
QuarkXPress 7 comes with two different types of layers: the de-
fault layers palette, which has the same functionality as in
InDesign, and the XPert Layers palette, which builds on the lay-
ering concept to provide the user with more functionality.

XPert Layers has no equivalent in InDesign CS3. A short
overview of the XPert Layers palette shows that users cannot
just add items to layers, but can add items to layers by selecting
the items and creating the layer in one step. e XPert Layers
palette puts every item that has not been selected on its own
virtual layer. Combined with dedicated buttons and icons,
this enables users to quickly move through a set of linked
text frames.

bEnChmark

observations

e XPert Layers palette and the default palette in QuarkXPress
7 are not compatible. e user must select one or the other.
Given the scope of functionality the XPert Layers palette is
claimed to have, the benchmark tests whether there is any time
savings to be had from using the XPert Layers palette compared
by using the default palette in both QuarkXPress 7 and
InDesign CS3.

test objects and methods — e XPert Layers palette
was tested using the following actions:

1.Cycle through different objects that are stacked on
top of each other and change their stacking order

2.Selecting different objects scattered over different
pages and collecting them in one layer

3.Find all linked text frames.

e third test involves a very simple layout where only one text
frame has to be linked to another one on a page, three pages
down from the first.

benchmark result 1

benchmark result 2

Cycle through objects covering each other

NOTE: e difference is explained by the
XPert Layers palette enabling users to
change the stacking order in the palette,
with visible feedback in the form of a
stacking number

Selecting different object on different pages, and group in layer
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benchmark result 3

NOTE 1: Linked text frames in Indesign CS3 can’t be found
unless the user turns on the invisible “chains” and navigates his
way through these chains visibly, from page to page. With the
XPert Layers palette, linked text frames are automatically recog-
nised by the palette, and the user can cycle through all linked
frames by clicking one icon in the palette.

NOTE 2: Adobe has provided for three palette modes in
InDesign CS3, Photoshop CS3 and Illustrator CS3. While the
user can chose to show palettes as they have been available in
previous versions of Illustrator and Photoshop, he/she cannot
revert the palette system back to the InDesign CS2 mode.

Palettes may seem irrelevant to productivity but the 2 new
modes (collapsed icon mode and expanded icon mode) Adobe
has chosen to add to the palettes system look nice, but keep
users from using the application in the fastest possible mode.
Users who want to work fast, will therefore revert to the old-
style palette mode.

e problem with the two new icon modes is that different
palettes cannot be open simultaneously. When a user is work-
ing with the Layers palette and wants to side-step to correct
something quickly, using the Colors palette, the Layers palette
will collapse and in order to jump back to it, the user will have
to re-open the Layers palette.

is is contra-productive. Additionally, on the Apple Macin-
tosh platform, Adobe has broken the Human Interface Guide-
lines as imposed by Apple, and which serve to deliver users a
unified user interface that enables them to work without think-
ing about their next move.

Find all linked text frames
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TaSk: copying and pasting objects
across a document

InDesign CS3 and QuarkXPress 7 both come with extensive
copy and paste capabilities. InDesign CS3 offers two modes of
copying and pasting: through the regular keyboard short-
cut/menu item, and by dragging and dropping text or objects
across a layout document. In order to drag and drop text in lay-
out mode, the user has to activate this capability in the Prefer-
ences. Otherwise, drag-and-drop copy/paste only works in
story editor mode.

QuarkXPress 7 only supports drag-and-drop copying and past-
ing of text when checked in the Input tab of the Preferences,
and comes with XPert Paste, a palette which allows users to
paste objects in the exact same location on different pages.

bEnChmark

For this test, an item was copied and pasted to a different loca-
tion in the document outside of the viewing port — i.e. two
pages down from its original location.

Copy Paste Item
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TaSk: navigate a spread of 5 pages

InDesign CS3 comes with the new Pages palette, which enables
users to see in a thumbnail view what the page looks like.
QuarkXPress comes with the XPert Pilot palette. is palette
offers thumbnails that show users what the page looks like, and
lets them navigate the pages and spreads using the palette and
a red, resizable marquee. With Live Scrolling, users can scroll
the palette as well as the main window (synchronised) quickly.

InDesign CS3’s improved Pages palette now offers a better
thumbnail view of the active page and a better overview of
transparent areas on the page.

bEnChmark

e XPert Pilot palette was tested by creating a spread with 5
pages next to each other — as a layout designer would be forced
to do with some brochure types. e test measured the time
to navigate through the pages of the spread using the XPert
Pilot palette and without, by moving from page to page in the
main window.

navigating Spreads
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ChallEngE: create a long document,
chapters and table of contents

PrElImInary ConSIDEratIonS

Both InDesign CS3 and QuarkXPress 7 support long document
creation, i.e. booklets or books containing chapters, an auto-
matically generated Table of Contents and an Index. InDesign
CS3 contains technology migrated from Framemaker, a heavy-
weight SGML-based word processor that is currently only
available on Windows and Unix platforms.

QuarkXPress 7 has no visible SGML-foundation for its long
document features. Nevertheless, both applications use the
same metaphor to build a long document and its components.
e workflow is identical, but the details with which the user
steps through the workflow are somewhat different.

In QuarkXPress 7, a book is built by adding chapters to a book
palette, setting a Master chapter — a chapter which holds all
the document’s styles — by clicking in a column, and opening
chapters by double-clicking the chapter names in the
book palette.

InDesign CS3 follows the same set-up; only the icons are dif-
ferent. In InDesign CS3 the user also gets visual feedback over
which chapter has been opened in a design window.

e workflow differs somewhat where the creation of table of
contents and index are concerned. In InDesign CS3, building a
table of contents (TOCs and indexes are called ‘lists’ in
QuarkXPress —a less intuitive term than what InDesign uses)
is done by first synchronising the chapters across the book, so
that all chapters contain the same styles, on which the TOC will
be built. When synchronisation has finished, the user selects
“Table of Contents” from the Edit menu and selects the styles
that will designate the headings included in the TOC.

InDesign CS3 requires users to check the “Include Book Doc-
uments” in the TOC dialogue window for the system to be able
to build a book TOC. is extra step is unnecessary in
QuarkXPress 7. In QuarkXPress 7, the TOC is built by setting
up a list definition, synchronising the chapters, and then build-
ing the list in the List palette. Rebuilding the TOC in
QuarkXPress 7 doesn’t change the TOC styles when they have
been set up prior to building the TOC.

In InDesign CS3 the TOC styling showed random errors on
rebuilding. is behaviour was also noticeable in InDesign
CS2.

bEnChmark

For this benchmark, a book was created by adding chapters to
the Book palette in both InDesign CS3 and QuarkXPress 7, and
then building a Table of Contents.

observations
In QuarkXPress 7, adding chapters is only possible by adding
them one at a time from the file system list presented in the
Open File dialogue. We expected this to result in much longer
book building times, but were surprised to find that InDesign
CS3 did not fare much better. InDesign CS3 does allow users to
add chapters to the Book palette in batch, but the application
insists on saving these chapters as a special kind of file before a
user can start working with it and be sure the book functional-
ity will not be broken when a system crash occurs. As each
chapter needs to be saved one by one, the time savings result-
ing from the batch-add feature were almost completely undone
by the save operation. Nevertheless, InDesign CS3 still keeps
some of its performance benefit when adding chapters to a
book file. However, building a Table of Contents is faster in
QuarkXPress 7 because it involves fewer steps.

test objects and methods — A book document of 100
pages was created by assembling eight chapters saved as
individual files, then a Table of Contents was generated for the
book document.

adding Chapters

Creating toC

benchmark result for adding Chapters

benchmark result for generating the toC
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ChallEngE : Styling items

PrElImInary ConSIDEratIonS

InDesign CS2 contained the ability to create styles from for-
matted text and objects. InDesign CS3 has this capability as
well, and includes the ability to create styles from tables with
mixed design characteristics (such as thick and thin lines, dif-
ferent cell shades, etc.).

QuarkXPress 7 comes with XPert ItemStyles. Unfortunately,
XPert ItemStyles does not work with tables. It does, however,
apply to all the styles of an object. is means a user can set de-
sign options for a frame and the contents of the frame, and
XPert ItemStyles will allow the user to save all these styles, in-
cluding those for the content. InDesign CS3 does not save the
styles of an object’s content (a picture within a frame, for ex-
ample). If a user wants to preserve the content styling as an ob-
ject style as well, he/she will have to explicitly save the design as
a separate object style.

InDesign CS3 has a single transparency setting for a whole
table. QuarkXPress 7 has transparency settings on a per-
cell basis.

bEnChmark

is test falls apart in 2 tasks. First, a frame with an image was
created. e frame was given a border and a gradient fill char-
acteristic, while the image within was given a drop shadow. It
was attempted to save the combined styles as one object style
(see above for the remark on InDesign).

e second task involved creating a table with simple format-
ting including different cell borders and global table trans-
parency, and then applying that formatting to three other tables
on consecutive pages in the document.

observations
Both tests resulted in InDesign being faster. e explicit saving
as an object style in the case of InDesign did not add signifi-
cantly to the time it took to create the styles and apply them in
the first place. In the case of table styles, the difference is more
pronounced, but the resulting design is less flexible. As
InDesign CS3 can’t create transparency on a per-cell basis, for
the sake of comparibility, the test did not include this. Whether
per-cell transparency is perceived as important depends on the
designer and the design.

Creating object style and applying

Creating table style and applying to 3 tables

benchmark result 2

benchmark result 1
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ChallEngE: working with
transparency and blending effects

PrElImInary ConSIDEratIonS

With QuarkXPress 7, Quark has included powerful trans-
parency and blending capabilities, both for images, tables and
table cells. InDesign CS3has a complete set of effects including
feathering, blend modes, and transparency, which users would
normally need to open Photoshop for. Additionally, InDesign
CS3 delivers users with effects that are unavailable in
QuarkXPress 7, e.g. applying a blending mode to a picture with
text on the underlying InDesign text layer.

Working with transparency in QuarkXPress 7 involves setting
an opacity figure in the Colors palette. Everything that can have
a colour, can have an opacity setting. Additionally, layered Pho-
toshop PSD files can have different blending effects internally
without having to open Photoshop. However, blending an
image with a text frame or other image underneath is impossi-
ble. is is only possible with InDesign CS3. To achieve simi-
lar effects, QuarkXPress 7 users will have to use Photoshop
both for the covering content and the content underneath.

In QuarkXPress 7, users can apply a gradient to a QuarkXPress
frame (or even the text itself) that blends from a solid colour
to a colour of None. is allows a text or picture frame under-
neath to show through where the blend ends in the colour
of None.

In InDesign CS3, fading a colour from solid to None is impos-
sible. Adobe has added some of the “Fx-effects” which were
previously only available in Photoshop CS2 and later. e clos-
est InDesign CS3 comes to the QuarkXPress 7 blend to None
feature is through one of the three “feather” Fx-modes deliv-
ered with InDesign CS3.

e QuarkXPress 7 result can be seen in the first screenshot,
the closest result possible in InDesign CS3 in the second one.
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An advantage of the QuarkXPress 7 approach to transparency
blending is that a user can combine the transparency to None
of a text frame with a drop shadow. Drop shadows in
QuarkXPress 7 are applied to text only when the colour of the
text frame background is set to None or anything else then a
100% applied colour. Combined with the gradient from a solid
colour to None, a drop shadow can be applied with a subtle effect.

is is an effect that cannot be achieved in InDesign CS3.
In order to achieve an effect that is closest to the one
in QuarkXPress 7, the user has to resort to combining different
effects with blending modes (which still don’t generate
the same result) or to create the effect outside InDesign CS3,
e.g. in Illustrator.

InDesign CS3 does offer other powerful transparency and
blending effects. e Blend dialogue offers almost all the blend
modes available in Photoshop, such as Linear Light, Multiply,
etc. is allows users to achieve effects such as reverse-coloured
text showing through an image on top of the text.

Since the creation of these effects is very hard to measure, there
is no benchmark for them. In the end, QuarkXPress 7 and
InDesign CS3 both have their set of creative filters and effects
which result in different “looks”. However, it has no sense
discussing which of these are more valuable or look better.
Both sets of effects do provide the user with a good basic tool-
box of graphic capabilities that enable them to create profes-
sional documents.

Effects and layouts: from print to web
In QuarkXPress 7, the effects applied to items are applied re-
gardless of the layout type that is using these effects. In Web
layouts, when the effects make a rendition to text impossible,
QuarkXPress 7 exports a HTML file containing the elements
converted to GIF images and a Javascript loader. When the ef-
fects are not making a textual conversion impossible, the con-
tent is exported and styled through CSS.

e result is a XHTML 1.1 document that looks fine in a
browser with basic CSS and Javascript capabilites. Despite the
Premium Creative Suite’s inclusion of the industry-standard for
web development, Dreamweaver CS3, there is no integration
between InDesign and Dreamweaver.

As shown above, InDesign CS3 only succeeds at exporting a
very basic XHTML file without any formatting at all. Design-
ers who hope to save time by using InDesign snippets and ex-
port them into Dreamweaver CS3 will find Dreamweaver CS3
does not recognise InDesign snippets yet. In short, there a de-
signer cannot speed up cross-media publishing because of the
presence of Dreamweaver CS3 in the Premium Creative Suite
box.

With InDesign CS3 only exporting the most basic XHTML
content with no formatting applied at all, the user must create
all formatting in Dreamweaver CS3. is increases the risk of

ending up with a design that no longer matches that of the
printed matter — or only aer considerable effort. e lack of
proper XHTML styling on export in InDesign CS3 also makes
this application less suitable for cross-media prototyping.

We would at least have expected InDesign CS3 to generate some
kind of template that could serve as a foundation for the
Dreamweaver user to build upon.

InDesign CS3 has no support for Flash. e three export for-
mats supported are XHTML for Dreamweaver, HTML for
eBook creation, and XML.

Compared to QuarkXPress 7, InDesign CS3 has poor support
for cross-media publishing, whereas QuarkXPress 7 seems to
be better equipped for cross-media publishing, including sup-
port for Web design, and Flash animations and presentations
(when the optional Interactive Designer is installed and avail-
able). QuarkXPress 7 exports to HTML, XHTML, XSLT, XML,
and Flash (SWF).
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ChallEngE: working with imported
TIFFs and PSD (photoshop) images

PrElImInary ConSIDEratIonS

InDesign CS3 depends on the Photoshop CS3 component of
Creative Suite to add effects to pictures that will be incorpo-
rated into a layout document. QuarkXPress 7 largely relies on
Quark Picture Effects to add effects. Only when Quark Picture
Effects has no corresponding effect available, Photoshop has to
be started. e effects in Quark Picture Effects are selected
based on their usefulness for the layout designer.

Furthermore, it needs to be stressed that QuarkXPress 7 offers
the capability to save picture effects as pre-sets, just as Photo-
shop CS3 does.

Another functionality in QuarkXPress 7, which is less effi-
ciently implemented in InDesign CS3, is the capability to apply
an alpha mask to the image, even as the image is imported in
the layout. A test was set up with a TIFF image that has three
alpha channels to choose from. In QuarkXPress 7, the image
could be imported as usual, and the three alpha channels could
be selected by opening the “Modify” dialogue box and check-
ing the desired alpha channel.

In InDesign CS3, in order to activate an alpha channel it has to
be selected on import, and cannot be swapped for a different
alpha channel, except by importing the image again. e time
it took to select a different alpha channel in QuarkXPress 7 in
this case was exactly half the time it took in InDesign CS3.

Note that “Edit Original” in InDesign CS3 to select a different
alpha channel, doesn’t work if the user wants to apply a differ-
ent channel to the image. Finally, if an alpha channel must be
applied to multi-placed images, they need to be re-imported
one by one.

Importing a Photoshop PSD file follows the same basic rules in
both the applications. While InDesign CS3 relies on Photoshop
CS3 to change channels, paths, or layer blending, QuarkXPress
7 delivers all these characteristics in its own PSD Import palette.
is palette allows users to change opacity between layers, layer
blending, channels, and Photoshop paths. One limitation of the
PSD Import feature is that it doesn’t support adjustment layers
or Photoshop effects.

bEnChmark

A photograph was added to a layout, and a Gaussian Blur was
applied. e time includes the startup time of Photoshop CS3.
e stopwatch was started aer the photo had been imported
into the document.

benchmark result
Creating guassian blur
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InDesign CS3 has the Illustrator PathFinder and a new
runaround palette to ensure text can be run around objects in
many different ways: around the bounding box, detected edges,
alpha channels, a Photoshop path, graphic frame, and user-
modified path. Adding a drop shadow to an object, however,
makes the text disappear behind the shadow contour. To avoid
this, the user will set larger margins for the run-around.

QuarkXPress 7 ensures text can be successfully run around
objects, even around their clipping paths, alpha channels, drop
shadows, non-white areas, automatically detected image
boundaries, picture bounds, and detected edges. QuarkXPress
7 also enables users to select one of multiple alpha channels
in an image file in the Measurements palette and use this as
a mask.

bEnChmark

For this test, an image of a dissected brain with a Photoshop
clipping path and a separate alpha mask that was saved in PNG
format, was placed in a layout in InDesign CS3 and in
QuarkXPress 7. e alpha mask being a separate file, this
information was initially disregarded.

benchmark result

observations
In QuarkXPress 7, the image edges were correctly determined
using the Runaround settings that are available for each frame.
With XPert Boxtool’s “Picture Box Shape From Path” func-
tionality, we were able to quickly create a clipping path, which
automatically made the text flow around the irregular shape of
the brain image.

In InDesign CS3, this runaround effect could not be achieved
without the image being loaded in Photoshop first and have its
transparency mask applied. Even InDesign’s edge detection did
not work, nor did the Photoshop clipping path — which was
recognised— make the text wrap around the image correctly.

Even with the alpha mask applied and the image saved as a
TIFF file with transparent areas, InDesign CS3 would not wrap
text around the image path correctly. Only when the alpha
mask was physically saved with the file would InDesign CS3
wrap text around the shape.

Creating irregular runaround

NOTE: e time recorded for InDesign CS3 does not include
the time it took to edit the file in Photoshop CS3. Because of
difficulties experienced with the text wrap feature in InDesign
CS3, this time surpassed the 3 minutes mark.



TaSk: link and unlink text frames

Working With Layouts

3�

In QuarkXPress 7, users have two methods to link, unlink, and
split existing text links. ey can either use QuarkXPress link-
ing arrows, or XPert Textlink. XPert Textlink provides a palette
for linking, unlinking and managing linked frames.

InDesign CS3 offers one method to link and unlink text frames:
using the frames’ exit ports, users can chain frames together.
By removing a frame from the chain, the text is re-flowed inside
the remaining text frames.

bEnChmark

is test measures the efficiency of the different text frame link-
ing methods offered by both applications.

observations
is test resulted in no difference between the QuarkXPress
7 XPert Textlink method and the InDesign CS3 exit
port manipulation.

However, a large difference became apparent when we tested
how long it would take to split a text chain at a specific word in
a paragraph (i.e., it was to become the first word in the split
frame that was unlinked aerwards). is took exactly the same
time in QuarkXPress 7 with XPert Textlink as it took to set up
the text links — not surprisingly so, as the XPert Textlink
method is based on positioning the cursor at the appropriate lo-
cation and clicking one of the 6 palette buttons.

In InDesign CS3, the same operation required manipulating
the text frames in such a way that the word where we wanted
the split to appear was at the start of the frame.

benchmark result

test objects and method — To test the available linking
methods, 3 frames were linked together, aer which the frame
in the middle was removed from the chain. is was first done
without taking notice of where the frame linking was broken.
e same test was then repeated, taking into account a specific
location where the frame link had to break.

text linking
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ChallEngE: prepare layouts for
printing on a printing press

A printing layout of a magazine or a book cannot be printed to
a press directly from a layout application. It must first be
impositioned. Furthermore, many items on a spread need
special marks in order for the printer to know how to print and
cut them.

Press marks and crop and registration marks are the domain
of Quark’s optionally available Quark Print Collection. Quark
Print Collection includes Item Marks, which manages crop
marks and registration marks. MarkIt enables users to add press
marks to layouts, while Imposer creates printer flats. Imposer is
also available for Adobe Acrobat.

InDesign CS3 comes with basic booklet capabilities included.
e imposition capabilities are light-weight (up to 12 pages
max) but free. For larger imposition jobs, users must use Im-
poser in Acrobat. QuarkXPress 7 users can use the Quark Print
Collection product, for which a benchmark has been included
in this report. Users of QuarkXPress 7 get the extra function-
ality from Item Marks and MarkIt, and benefit from the early
impositioning capabilities QuarkXPress 7 thus delivers.

Item Marks enables users to set up trim, bleed and safety areas
with one dialogue window. MarkIt allows users to add cus-
tomisable press marks to their layouts. Different sets of press
marks can be saved and edited. Imposer, both in QuarkXPress
7 and Acrobat, offers 3 sheet types and 5 imposition types.

bEnChmark

To test the Print Collection, the following setup was used:

• To an item on a page, a trim and bleed area
was added

• Press marks were added to a layout

• An impositioning setup was created in QuarkXPress
7 and subsequently in Acrobat.

observations

Adding a trim and bleed area to an item on a page in InDesign
CS3 involves creating the lines and arrows manually. e first
chart therefore shows a large difference between QuarkXPress
7 and InDesign CS3.

e second chart represents the time it takes to print a docu-
ment with press marks. Here, Quark Print Collection offers the

ability to create custom press marks. e graph does not show
the time it takes to set up such custom press marks, but an av-
erage of 01:26.00 (one and a half minutes) is a realistic figure,
depending on what the press marks should include.

e third chart represents the impositioning test. e InDesign
CS3 value is composed of 00:41.68 spent exporting from
InDesign CS3 to Adobe Acrobat 8.

test objects and method — For the first test item marks
were added to an image on a page. e second test involved
adding printer marks such as bleed, crop marks, etc. e third
test shows the result of impositioning a 40-page document.

3. Printing and Output
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adding printer marks

Imposition

Item marks

benchmark result 1

benchmark result 2

benchmark result 3
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Task: scale page elements and prepare
for flexo printing

QuarkXPress 7 supports flexographic printing through the
XPert Scale XTension. InDesign CS3 has no built-in support
for flexo printing. XPert Scale enables users to scale elements,
objects, and complete layouts.

In QuarkXPress 7, the user has control over the components of
an item on which scaling happens, e.g. whether the font size is
affected by the scaling operation. Users also control whether
styles are adjusted automatically, if units must be used or per-
centages, etc. Finally, users can control where the scaling mid-
point is located. is means a scaling operation can scale the
item starting from its centre, or from its top le corner point.

Additionally, flexographic printing becomes possible by select-
ing the “Flexo” item in the Print dialogue and setting the ap-
propriate percentages.

In InDesign CS3, scaling an object or a text box is done by using
the Object Scale dialogue. is dialogue only enables control
over the scaling percentage and has a preview checkbox.
InDesign CS3 users cannot scale a complete layout. In
QuarkXPress 7, all the pages and elements in a layout can be af-
fected by the scaling operation.

bEnChmark

e benchmark shows a basic scaling operation. To calculate
how much time the scaling of a complete layout in InDesign
CS3 will take, the reader must multiply the test figure by the
number of spreads in the layout. InDesign CS3 not allowing for
multiple spreads to be selected, a scaling operation on a com-
plete layout cannot be executed in one operation.

benchmark result

Scaling items
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Task: Exporting to PDF/x-1a:2001

Adobe being the original developer of the PDF specification,
InDesign CS3 should offer the fastest export capabilities to PDF
and Certified PDF. When exporting to PDF, InDesign CS3 cy-
cles through at least two dialogues whenever a layout contains
“special” effects like transparency.

QuarkXPress 7 doesn’t go through extra dialogues when ex-
porting to Certified or ordinary PDF. It just exports.

bEnChmark

A layout with some transparency objects was exported to
PDF/X–1a:2001 from within InDesign CS3 and QuarkXPress
7. e resulting PDF file was then preflighted in Markzware’s
FlightCheck Pro 6 to check it for Certified PDF inconsistencies.

observations
e preflight session revealed that both applications make the
same error: the Title header in the meta data field for the PDF
file did not read correctly. e “a” was le out of this field. For
the rest, both files preflighted fine.

test objects and method — e test measures the time
it took to export the file.

benchmark result

Export to PDF/x-1a:2001
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In QuarkXPress 7 and InDesign CS3 there are a number of fea-
tures that help productivity, such as customised menu items
and custom keyboard shortcuts in InDesign CS3, and XPert
Toolbars in QuarkXPress 7.

QuarkXPress 7 XPert Toolbars provide for direct access to
commonly used commands and menu items. Toolbars offer
buttons for items the user defines. InDesign CS3 has no toolbar
feature, but instead offers users the ability to set up their own
keyboard shortcuts and show only those menu items that are of
interest to them.

It is impossible to measure the benefits of one customisation
method over the other, as this is all very much determined by
personal taste and working habit. People who like to memorise
shortcuts will dislike the Toolbar feature, while people who like
to work with icons and buttons will like the XPert Toolbar func-
tion and won’t understand why InDesign hasn’t such a feature.

bEnChmark

Setting up a shortcut set and a Toolbar costs time. We tested
how much time it would cost to set up a toolbar in
QuarkXPress and shortcuts in InDesign CS3 giving access to
the Kern Track, Paragraph Style Sheet, and Arrowheads.

e Paragraph Stylesheets test was aborted without timing
results, as InDesign CS3 has no way of setting up a shortcut
that will show the Paragraph Stylesheets outside of the
Stylesheet palette.

observations
Another productivity enhancing feature in QuarkXPress 7 for
which no equivalent exists in InDesign CS3, is XPert Type.
Xpert Type is a palette with three tabs: Type, Paragraph, and

Rules. e palette enables a quick adjustment of those three
functions using either the up and down arrows on the palette,
or by dragging the mouse in the text.

InDesign CS3 does offer a quick, up-and-down arrow-based
resizing of characters and adjustment of paragraphs, but set-
ting these values by mouse is unique to the XPert Type palette.
However, we found the dragging behaviour to be too rough to
be of much use without extra refinements.

e XPert BoxTools adds quickly accessible nudging capabili-
ties to QuarkXPress 7 with a lot of control over the nudging
value, which can be set to 0.0001 pt or —for rotation pur-
poses— to 0.0001 degrees. In InDesign CS3 nudging is done
by the keyboard only. e user has to memorise the key com-
binations.

InDesign CS3 has a new feature called Quick Apply to auto-
mate repeating actions. Quick Apply is a list of all the styles,
menu and other commands that are available throughout
InDesign CS3 —it’s a sort of unstructured list of all the com-
mands and actions that are possible in the program, grouped
together in 8 subcategories. rough Quick Apply, a user can
nudge, resize, and perform all the other tasks that QuarkXPress
7 makes possible through some of its XPert palettes.

e problem with Quick Apply is that users must type the com-
mand name they’re going to use to narrow down the list. is
results in the chosen command’s name floating to the top of the
list the first time the user applies Quick Apply. All subsequent
clicks on the Quick Apply icon will open the dialogue with the
search term still in the keyword field.

benchmark results

4. Miscellaneous Items

toolbars and shortcuts
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About this report

!is report presents the "ndings of a research and benchmarking study com-
missioned by Adobe Systems Incorporated. !e aim of the study was two-
fold: to analyze key technology differences between Adobe InDesign and 
QuarkXPress, and to assess the efficiency and productivity of the latest 
release of the two products in the speci"c work#ow situation of magazine 
and newspaper publishing.
About the Research

Productivity measures, based on the Pfei"er Consulting Methodology for 
Productivity Benchmarking, compared work#ow productivity of Adobe 
InDesign CS4 and QuarkXPress 8. 
!e speci"c focus of the benchmarks was e%ciency in magazine and newspa-

per design and production. !is document presents results and analysis speci"c 
to the newspaper publishing market; magazine-publishing speci"c "ndings are 
presented in a separate document.

In addition to the research conducted speci"cally for this project, this report 
also draws upon an independently financed study and research report con-
ducted by Pfei&er Consulting, comparing previous releases of both products. 
(!e complete report is available at the Pfei&er Consulting Document Store 
http://pfei&erreport.com/store.)

For more information on the methodology of the benchmarks, please refer 
to the Methodology sidebar on page 3. For detailed information on hardware 
con"gurations, methodology, discussion of benchmarks and complete results, 
download the complete Adobe InDesign CS4 vs. QuarkXPress 8.0 Benchmark 
Report at www.pfei&erreport.com.
About Pfeiffer Consulting

Pfei&er Consulting is a Paris-based, international research and consult-
ing operation specializing in technology and media. Pfei&er Consulting’s 
mission is to provide unique high-level, international market intelligence and 
strategic consulting for both content and technology providers.

Pfei&er Consulting is the publisher of the Pfei"er Report on Emerging 
Trends and Technologies, an online resource on trends in the technology and 
content industry, as well as numerous specialized studies and reports.

For more information on Pfei&er Consulting’s reports and services, please 
visit www.pfeifferconsulting.com.

Major Findings

 t InDesign CS4 offers a sophisticated 
environment for design and publishing 
that offers many features that are 
unmatched by the competition.

 t In benchmarks conducted for this project, 
InDesign CS4 showed a clear productivity 
advantage over QuarkXPress 8.0 in 
many essential operations for the 
newspaper publishing workflow.

 t The integration with InCopy CS4 and 
the support of an extensive range of 
editorial workflow systems allow for 
InDesign CS4 to be efficiently deployed 
in newspapers of any size and workflow 
complexity.

About Pfeiffer Consulting

 t Pfeiffer Consulting is an independent 
technology research institute and 
consulting operation focused on the 
needs of publishing, digital content 
production, and new media professionals.

 t Download the complete Adobe 
InDesign CS4 vs. QuarkXPress 8.0 
Benchmark Report at 
www.pfeifferreport.com.

Pfeiffer
Consulting

01001011

Adobe InDesign CS4  
vs. QuarkXPress 8: 
Efficiency in Newspaper 
Design and Production
 
Technology, design and productivity
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Comparing two mature page layout environments

Comparing InDesign and QuarkXPress is not an easy task; giving a fair, bal-
anced evaluation of both environments is even more di%cult, despite only 
focusing on one speci"c market segment, such as newspaper production in the 
case of this study.

While both QuarkXPress and InDesign were designed for the same task 
(page layout) and use a similar basic approach (text and picture frames con-
taining imported content, combined with graphic elements such as rules and 
boxes), the programs take very di&erent roads to achieve certain tasks, and 
each one has some strengths that the other lacks: QuarkXPress, for instance, 
features a highly customizable hanging punctuation feature, but lacks the 
sophistication and e%ciency of the text composition engine in Adobe’s prod-
uct. InDesign CS4 allows the application of Photoshop e&ects such as bevel 
and emboss to graphic elements including texts and shapes, but lacks the 
possibility of applying basic "lters to pixel images. And there is a long list of 
features that both programs share, but that are implemented in entirely di&er-
ent ways and o&er di&erent twists and options.

On the following page we analyze the approach of both applications to key 
aspects of the publishing process. Sidebars and illustrations throughout this 
document will provide productivity information and technical discussion of 
the key di&erentiating factors between the two page layout environments.

Major Points

 t InDesign CS4 provides design options 
unmatched by the competition, and offers 
mature integration with the key applications 
for design and publishing, such as 
Photoshop CS4, Illustrator CS4, Flash CS4 
as well as Bridge CS4.

 t Based on benchmarks for this research, 
InDesign CS4 offers a clear productivity 
advantage in terms of object composition, 
image placement and management, 
repetitive text formatting as well as PDF 
export.

 t InDesign offers support for PostScript 
level 1,2 and 3 and provides a PDF-based 
print-engine that supports a media-neutral 
workflow.
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Effects
Effects
Effects

InDesign is the only page layout program that o"ers the ability to paste a 
design element into any kind of frame, allowing designers to crop any text or 
graphic element, the way they would do with an imported picture. 0is o"ers 
not only great creative potential but increased productivity. (In the example 
on the left, a complete, editable table has been pasted inside a round frame.) 

InDesign CS4 not only supports transparency e"ects and drop shadows, but 
allows users to apply and combine a wide range of Photoshop e"ects (such 
as bevel, inner shadow and inner/outer glow) to graphic elements and text. 
All e"ects can be set individually for the stroke, 1ll and content of a selected 
element or group of objects, reducing the need for e"ects work in Photoshop.

InDesign and QuarkXPress: 
Key Technology Differences

© Pfei"er Consulting 2009
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This report is based on technology 
analysis and market-specific productivity 
benchmarks conducted by Pfeiffer 
Consulting for Adobe Systems 
Incorporated. It also includes elements 
from independent research and technology 
analysis projects conducted by Pfeiffer 
Consulting.

Productivity Measures

Pfeiffer Consulting conducted extensive, 
market-specific productivity benchmarks 
comparing Adobe InDesign CS4 with 
QuarkXPress 8.0, focusing specifically on 
common tasks in newspaper and magazine 
publishing.
Nature of benchmarks: Experienced 
professionals performed segment-specific 
design assignments, defined in clearly 
repeatable steps and executed in a closely 
monitored way. To ensure real-world 
results, no scripting was used for any 
benchmarks.
Hardware: All benchmarks were conducted 
on a factory configured Mac Pro 
workstation equipped with 4GB of RAM 
running Mac OS X 10.5.6. Benchmark 
systems were completely re-initialized prior 
to tests.

All statements in this report are factual 
and can be independently verified. For 
in-depth discussion of the benchmark 
methodology, system configurations, and 
comprehensive benchmark description and 
results, please download the complete 
“Adobe InDesign CS4 vs. QuarkXPress 8.0 
Benchmark Report” at our website 
www.pfeifferreport.com.

All texts and illustrations © Pfei"er Consulting 2009.  
Reproduction prohibited without previous written approval. 
For further information, please contact research@pfei!erreport.com.
0e data presented in this report are evaluations and generic simulations and are commu-
nicated for informational purposes only. 0e information is not intended to provide, nor 
can it replace speci1c productivity research and calculations of existing companies or work-
2ow situations. Pfei"er Consulting declines any responsibility for the use or course of action 
undertaken on the basis of any information, advice or recommendation contained in this 
report, and can not be held responsible for purchase, equipment and investment or any other 
decisions and undertakings based on the data provided in this report or any associated docu-
ment.
Adobe, Acrobat, Illustrator, InCopy, InDesign, Photoshop, Flash, After E"ects, 
Dreamweaver, Fireworks and Version Cue are either registered trademarks or trademarks 
of Adobe Systems Incorporated in the United States and/or other countries. Mac and 
Macintosh are trademarks of Apple Computer, Inc., registered in the United States and 
other countries. OpenType and Windows are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. QuarkXPress is a regis-
tered trademark of Quark, Inc. in the United States and/or other countries. All other trade-
marks are the property of their respective owners.

Design efficiency: While basic design techniques are similar in both environ-
ments, InDesign o&ers an essential design feature QuarkXPress lacks, the 

“Paste Inside” menu command that lets users paste groups of objects inside 
pre-existing frames (see sidebar on previous page). QuarkXPress  8, on the 
other hand provides a sophisticated content tool that let users resize and rotate 
imported pictures without changing tools.
Composition engine: InDesign clearly has the more sophisticated text com-
position engine, o&ering a paragraph-based justi"cation method and glyph-
scaling as part of H&J (Hyphenation and Justi"cation), as well as more sophis-
ticated, dictionary-based hyphenation, yielding better-looking text composi-
tion without manual adjustments, essential for e%cient newspaper publishing. 
Hanging punctuation support is much more sophisticated in QuarkXPress 8, 
but customizing pre-sets is complex for occasional users.
Text handling: Beyond basic text handling features, similar in both applica-
tions, InDesign o&ers a signi"cantly more sophisticated style sheet architec-
ture. Nested styles allow for e%cient combination of paragraph and character 
styles. !e program also o&ers GREP-based search and replace, and supports 
footnotes, a feature QuarkXPress still lacks. Conditional text and text vari-
ables can also speed up InDesign publishing work#ows. QuarkXPress, on the 
other hand, o&ers a Shared Content feature that allows to synchronize text 
and pictures between di&erent layouts within the same project.
Picture handling: Both programs support key "le formats for design and 
page layout, including Photoshop, Illustrator and PDF "les. Not surpris-
ingly, support for Adobe "le formats is clearly more mature in InDesign CS4. 
(QuarkXPress can handle some aspects of Photoshop "les InDesign does 
not currently support, such as transparency-adjustment of individual layers, 
but does not support the complete range of layer types Photoshop can create, 
such as adjustment layers and layer masks, making it incompatible with many 
Photoshop "les.)
Application integration: InDesign CS4 bene"ts from the tight integration 
with other key applications of the creative and publishing work#ow, including 
metadata support for placed images and "le format integration between vari-
ous applications. !e program also includes Bridge CS4 for managing docu-
ments and metadata of the creative and publishing work#ow. QuarkXPress 8 
supports drag-and-drop "le placement from Bridge.
Multimedia support: Both InDesign and QuarkXPress can create interactive 
documents that can be exported as web-ready SWF "les for playback with 
the Flash Player. InDesign CS4 can also create XFL "les that can be opened 
in Flash CS4, and exports a much wider range of interactive features to PDF 
than QuarkXPress does.
!e approach to interactivity between the two products varies signi"cantly, 
though: users need to create speci"c “layout spaces” in a project depending on 
the desired output (print, interactive or web), while InDesign lets users add 
interactivity and hyperlinks to standard InDesign documents.

Smart Guides in InDesign provide interactive positioning and dimensioning help during 
the page layout process. 0e impact of Smart Guides on productivity is considerable, as the 
benchmarks for this project show: in all tests, positioning elements using Smart Guides was 
over twice as fast as achieving the same result with QuarkXPress.

Productivity Impact of Smart Guides on Object Positioning
Time in seconds. Shorter is better.

0 3 6 9 12 15

0 3 6 9 12 15

Align and arrange
three objects

at equal distance

Align object
with two others

(horizontal/vertical)

Simple alignment
of two objects
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5.65

13.25

QuarkXPress 8

InDesign CS4
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Understanding the issues

E%ciency in newspaper publishing depends on a variety of factors. Newspaper 
design and production are very sophisticated domains, and tools for this mar-
ket have to allow the creation of sophisticated templates and variations, as 
well as extremely high e%ciency in text formatting and image handling.

InDesign was conceived in the late nineties, almost a decade after the "rst 
generation of page layout programs. !e program made a point of taking a 
fresh approach to some of the most basic tasks and requirements of the pub-
lishing process, and added sophisticated controls and features to the basic 
page layout tool-set. While QuarkXPress has been extensively improved and 
rewritten over the past years, some of the basic limitations of the program 
remain: InDesign, for instance, has always o&ered layers on master pages 
(essential for e%cient template creation, particularly in newspaper publish-
ing) while QuarkXPress only o&ers layers on the content pages, but not on 
masters; InDesign can place guidelines on layers, thus allowing them to be 
selectively masked, as well as copied and pasted, while QuarkXPress treats 
them as page-speci"c, independent from the layer architecture.
Productivity related to text handling

Similarly, text handling features, and in particular style-sheets, start o& with 
the same core functionalities in both programs, but Adobe has pushed the 
possibilities of this essential formatting tool far beyond the features provided 
by Quark’s options: as the productivity benchmarks for this research project 

Major Points

 t InDesign CS4 offers a more sophisticated 
and more efficient text composition 
engine, that includes support for character 
scaling as part of the H&J algorithm and 
provides more evenly spaced text without 
requiring manual fine-tuning. This is 
essential for efficient newspaper publishing.

 t InDesign CS4 provides a significantly 
more mature and sophisticated 
implementation of master pages than 
QuarkXPress 8, including hierarchical 
master pages and layers on master pages. 
These features are essential in newspaper 
publishing since they allow designers 
to structure publications for efficient 
production.

 t The style sheet architecture provided 
by InDesign CS4 is more robust and 
more powerful than its competition. This 
can significantly increase productivity in 
newspaper production.
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0e Nested Styles feature in InDesign allows automated use of character 
styles within a paragraph style sheet, signi1cantly speeding up repetitive 
formatting tasks. 0e chart on the left shows the time necessary to format 
5 paragraphs containing an opening phrase in bold face, using Nested Styles 
or manually applying the character styles. 0e chart on the right illustrates 

the productivity linked to automatically applying a set of linked styles used 
in repetitive formatting of magazine articles (such as headline, byline, 
introduction, body copy, etc.) to an imported text with the time necessary to 
apply the styles one by one. InDesign also allows this feature to be applied to 
multiple text frames (such as sidebars in a magazine spread) in one step.

Efficiency in  
Newspaper Publishing

© Pfei"er Consulting 2009
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Master pages are one of the features 
where InDesign provides a level of 
sophistication that goes well beyond 
its competitor, and offers newspaper 
publishers powerful ways of structuring 
templates that can be very easily adapted 
and customized.
Hierarchical master pages essentially 
allow a newspaper designer to structure 
page templates in a way that lets shared 
changes ripple through many variations 
of a design. Thus a designer can start 
by creating a basic page grid, and then 
use this as master page   for a series 
of sections. Each section master page 
can in turn become the starting point for 
variations of the section; changes made 
to one master page, like the basic page 
grid, will ripple through each master page 
based on this design. (By comparison, 
since QuarkXPress supports only one level 
of master page, a change in design shared 
by several master pages would need to be 
applied manually for each occurrence.)
In addition, InDesign supports layers not 
only on body pages, but on master pages 
as well, allowing magazine designers to 
create extremely efficient page templates, 
for example by grouping text and 
illustrations on layers that are unlocked and 
editable during production, while protecting 
fixed page elements on locked layers. The 
same page design can even offer several 
column configurations on different layers, 
that can be made visible depending on the 
requirements of a specific page.

clearly document, features such as Nested Styles and the “Apply Next Style” 
command can signi"cantly speed up repetitive production tasks in newspaper 
production and other publishing work#ows, particularly since they can be 
applied to groups of selected text boxes in one operation.

InDesign o&ers two more unique text handling features the competition 
lacks: Conditional text allows for easy switching between di&erent versions 
of a text, useful for instance when managing local editions of a publication, or 
di&erent versions of the same document; text variables can be used to manage 
repetitive text elements, and update them automatically across a layout docu-
ment when changes are required.

QuarkXPress  8 has an edge with some text-related features, however: 
hanging punctuation o&ers considerably more customization options than in 
InDesign, and the possibility of editing kerning pairs, which also supports 
OpenType fonts in QuarkXPress 8, is highly valued by some publishers. As 
for the Shared Content feature, it is useful for sharing and synchronizing 
texts and pictures between di&erent layouts in a QuarkXPress project "le.
Productivity related to image handling

We have already seen that both programs support most of the popular pixel 
and vector image formats. But how do InDesign and QuarkXPress compare 
in terms of placing and managing imported images?

Both applications allow text and image "les to be dragged onto a page from 
a Mac OS or Windows folder, or from an Adobe Bridge window, making 
multiple "le placement easier. Nevertheless, "le placement is one of the areas 
where InDesign CS4 provides a signi"cant productivity edge over its compet-
itor, by allowing multiple "les to be placed in a single operation: the feature is 
both easy to use and sophisticated, and even allows the creation of a frame at 
the exact proportion of the placed image, as well as the placement of several 
images as a grid of frames like a contact sheet.

Likewise, it is possible to place all or selected pages of a multi-page PDF or 
Illustrator CS4 "le in a single operation. Finally, InDesign allows the image-
"tting options for frames to be speci"ed prior to placement, meaning that 
a page layout can be set up in a way that imported images are immediately 
scaled proportionately as well as cropped or reduced by a pre-set amount, a 
feature QuarkXPress lacks.

QuarkXPress 8 innovated with a new picture content tool that allows imag-
es to be scaled, rotated and cropped in a single operation. !is feature, clearly 
more e%cient than InDesign’s current tools, streamlines the "ne-tuning of 
sophisticated page layouts; it is regrettable that Quark has not paired it with 
the image-placement and object-handling features InDesign o&ers.

InDesign’s composition engine is 
signi1cantly more sophisticated 
than its competitor, supporting 
paragraph-based hyphenation 
(QuarkXPress only calculates 
hyphenation on a single-line 
basis), as well as glyph-scaling as 
part of the H&J (Hyphenation 
and Justi1cation) algorithm, a 
clear advantage for type-setting 
documents with narrow columns.
0e example on the left shows the 
same text, typeset on a 6-column 
grid on an A4 page using 
exactly the same font, font-size, 
leading and H&J settings. 0e 
text typeset with InDesign (left 
illustration) appears much more 
evenly spaced, a result achieved 
by authorizing glyph-scaling in 
the basic H&J setting, a feature 
QuarkXPress currently lacks.
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Mr. Sherlock 
Holmes, 

who was usually 
very late in the 
mornings, save 
upon those not 
infrequent occa-
sions when he 
was up all night, 
was seated at the 
breakfa! table. I 
!ood upon the 
hearth-rug and 
picked up the !ick 
which our visitor 
had left behind 
him the night 

unfortunate as to 
miss him and have 
no notion of his 
errand, this acci-
dental souvenir 
becomes of impor-
tance. Let me hear 
you recon!ru" 
the man by an 
examination of it.”

“I think,” said I, 
following as far 
as I could the 
methods of my 
companion, “that 
Dr. Mortimer is a 
successful, elderly 

“Really, Watson, 

InDesign CS4 QuarkXPress 8
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No application is an island

InDesign o&ers a high level of integration not only with other key applications 
of the creative and publishing work#ows, but with the wide array of tech-
nologies and standards developed and supported by Adobe, ranging from the 
ubiquitous PDF format to the metadata architecture XMP, as well as support 
for XML, not included in QuarkXPress 8.0. !e obvious immediate ben-
e"t is of course tighter integration with applications such as Photoshop CS4, 
Illustrator CS4 and Flash CS4, as well as Bridge CS4. Quark has clearly 
recognized the need for tighter integration with Adobe’s tools: version 8.0 
of its #agship application supports "le import from Bridge, and now o&ers 
some support for native Illustrator "les, but it lacks the pervasive support for 
XMP, and cannot o&er the metadata integration that ties together all Adobe 
applications.
!e high level of integration provided by Adobe’s tools has some immedi-

ate bene"ts in terms of productivity. One of the best examples for this is the 
new Links panel introduced with the latest release of InDesign. Managing 
linked "les is essential in e%cient page layout and production, and the level 
of sophistication provided by InDesign CS4 goes well beyond any other page 
layout application on the market, including previous releases of InDesign.
!e highly customizable Links panel not only makes it much faster to locate 

linked "les and to check a wide variety of characteristics such as color space, 
resolution, ICC pro"les, creation and placement date, it can even display 
metadata such as the author of a placed image. Most importantly, it speeds 

Major Points

 t InDesign CS4 offers tight integration with 
other key graphics applications, including 
sophisticated support for native file-
formats, metadata support and wide-
ranging support for document-export 
to PDF, SWF and the Flash authoring 
environments.

 t InDesign CS4 provides a significant 
productivity advantage for handling 
images and text. Multiple-file-placement 
accelerates the production process, and 
the new Links Panel allows easy access 
to images, and increases efficiency in 
managing placed files.

 t PDF export from InDesign CS4 is faster and 
more mature than with QuarkXPress 8.0. 
and provides support for a wide variety of 
PDF format versions.
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Efficiency in Managing Placed Images
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QuarkXPress 8
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14.88

27.26

Productivity of Multiple File Placement
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QuarkXPress 8

InDesign CS4

0e new Links Panel in InDesign CS4 goes well beyond QuarkXPress in 
terms of features and productivity for managing placed 1les. 0e chart on the 
left shows the time necessary to relink 5 images placed in a page layout to a 
di"erent folder, signi1cantly faster in InDesign CS4.

Multiple 1le placement gives InDesign an edge in page-layout e3ciency: 
the program can import several individual image and text 1les in a single 
operation. QuarkXPress requires 1les to be imported or dragged individually 
into a page layout, requiring almost twice as much time (chart on the right).

Managing Content
and Production
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6 InDesign CS4 vs. QuarkXPress 8: Efficiency in Newspaper Layout and Production



InDesign offers one feature that is very 
useful in the newspaper production 
process: the integrated text editor, which 
offers a simple word-processor window for 
editing text that is placed in a page layout.
Editors can type their texts and apply 
style sheets or modifications without 
having to worry about the page layout 
and design tools interfering with their 
work, or about unwittingly modifying the 
design. In addition, the text editor in 
InDesign displays information such as 
style-sheets that are used, and alerts the 
user when overset text occurs. All this can 
be achieved while interactively seeing the 
changes to the text in the complete page 
layout.
InCopy CS4: In addition to the built-in text 
editor, InDesign CS4 offers integration 
with InCopy CS4, Adobe’s copy editing 
program. InCopy CS4, which is built on 
the same code-base offers full support 
for copy-fitting and tracking changes. 
With InCopy CS4, it is possible for several 
newspaper editors to work on different 
stories placed on the same page, without 
having to invest in a fully-fledged editorial 
system.

up everyday production tasks signi"cantly, by allowing operations such as 
relinking images to a di&erent folder, or to relink placed images to "les with 
a di&erent "le extension.
Preflighting

Paradoxically, InDesign CS4 and QuarkXPress 8 take both a very similar and 
a completely di&erent approach to detecting potential production problems. 
InDesign’s pre#ighting, available since its "rst release, was always geared 
towards the user, not the production expert.

Easy to use, it was also somewhat limited in scope in older versions of 
InDesign, and has been signi"cantly expanded in the CS4 release. !e Live 
Pre#ight functionality spots errors as they occur, and allows users to "nd and 
correct them easily. Initially, the program uses a default pre#ight pro"le, but 
creating new ones is a simple process.

QuarkXPress, on the other hand, did not o&er any pre#ighting in earlier 
releases, but introduced the powerful but somewhat unwieldy Job Jackets fea-
ture in QuarkXPress 7. Job Jackets are very sophisticated, and share some 
characteristics with pre#ight pro"les in InDesign CS4.

Practically speaking, setting up Quark’s Job Jackets requires a considerable 
learning e&ort, and the program does not provide default settings that would 
allow the average user to pre#ight a document without creating the appropri-
ate Job Jacket beforehand.
PDF support

One of the key di&erences between QuarkXPress and InDesign in terms of 
PDF support is that Adobe’s product uses the native Adobe PDF libraries for 
PDF creation, while QuarkXPress relies on a third-party conversion engine 
compatible with PostScript.

As a result, support for di&erent versions of the PDF standard is more 
sketchy in QuarkXPress: InDesign CS4 supports the full range of PDF/X 
standards and variants, while QuarkXPress 8.0 only supports PDF/X-1a:2001 
and PDF/X-3:2002. 

And while QuarkXPress can create sophisticated interactive projects, only 
hyperlinks are exported to PDF "les; InDesign can also export buttons, as 
well as page transitions.

Finally, in the benchmarks conducted for this project, PDF export was sig-
ni"cantly slower from QuarkXPress 8.0 than from InDesign CS4: Quark’s 
program took two to six times longer to export identical documents to  
PDF/X-1a than InDesign.
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0 50 100 150 200

Export
composite
document

to PDF/X-1a

Export 147-page
text-only

document
to PDF/X-1a

27.27
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18.51

36.78

PDF Export
Time in seconds. Shorter is better.

QuarkXPress 8

InDesign CS4

Illustration on the left: InDesign CS4 o"ers a Live Pre2ight feature that 
detects errors as they occur. 0e program is shipped with a default pre2ight 
pro1le that can be customized to detect a great variety of di"erent document 
aspects for both print and digital media output, including overset text, 
wrong color space or aspects such as TrueType outlines contained in an 

OpenType font. Chart on the right: PDF export is signi1cantly faster with 
InDesign CS4 than with its competitor. InDesign CS4 o"ers PDF export 
based on the original Adobe PDF libraries, while QuarkXPress 8 relies on a 
third-party conversion engine compatible with PostScript, and o"ers a more 
restricted range of PDF export options.
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Feature InDesign CS4 QuarkXPress 8

Creative Design 
Options

 t Graphic effects (emboss, glow, etc.) on graphic 
objects reduces need for graphic effects work in 
Photoshop or Illustrator.
 t “Paste Inside” allows sophisticated graphic design 
compositions without using other applications.
 t Support for transparency in Photoshop, Illustrator and 
PDF documents allows sophisticated integration of 
graphics from other applications.

 t Picture Effects lets users apply non-destructive image 
effects and filters to pixel images in common file 
formats (lacks support for Photoshop files).

Design and 
Workflow Efficiency

 t Drag and drop file placement for text and image files from operating system folders and Adobe Bridge.

 t Multiple file placement allows multiple images or 
multiple pages in PDF or Illustrator documents to be 
placed in one operation.
 t Proportional Place automatically creates an image 
frame at the proportions of the placed file.

 t Picture content tool allows images to be cropped, 
scaled and rotated without changing tools or using 
keyboard commands.

Advanced 
Page Layout 
Functionality

 t Hierarchical Master Pages allow the creation of 
sophisticated templates, that support simple update 
of shared characteristics between linked master 
pages.
 t Layer-specific guides allow the creation and switching 
between layout grids on the same page template.
 t Existing InDesign documents can be placed inside a 
page layout, and are updated as changes occur.

 t Composition Zones allow parts of a project to be 
shared by several projects and/or group of users.
 t Shared Content allows elements and settings to be 
shared among different layouts in one project.
 t Grid Styles makes management of multiple page and 
item grids easier.

Composition

 t Text composition engine supports glyph scaling as 
part of H&J (Hyphenation and Justification).
 t H&J can work with entire paragraphs, as well as line 
by line.
 t Dictionary-based hyphenation algorithm offers two 
levels of hyphenation.
 t Optical margin alignment provides simple, story-level 
hanging punctuation.

 t Sophisticated, customizable hanging punctuation can 
be integrated into style-sheets.
 t Editable kerning tables can be customized, saved 
and shared by user.

Text-Related 
Features

 t Support for nested style-sheets speeds up repetitive 
formatting operations.
 t Support for conditional text simplifies managing 
document variations.
 t Support for text variables speeds up repetitive 
document creation and adaptation.

PDF Support

 t Support for PDF/X-1a: 2001, PDF/X-3: 2002
 t Support for transparency in PDF files

 t Comprehensive support for PDF file variations, 
including PDF version 1.3 to 1.7
 t Support for PDF/X-1a: 2003, PDF/X-3: 2003,  
PDF/X-4:2008
 t Support for multimedia features in PDF files

Preflighting
 t Live Preflight spots errors as they occur, based on a 
default profile.
 t Simple creation of custom profiles that cover a wide 
range of document properties.

 t No default preflighting mechanism.
 t Job Jackets can be used for preflighting but require a 
non-trivial set-up procedure.

Image Handling
 t Links Panel gives users direct access to a wide range 
of image attributes, metadata and file information 
and allows batch relinking of files with the same file 
name but different extensions.

File Compatibility

 t Support for a variety of file formats including Photoshop, Illustrator, PDF, TIFF, JPEG, PNG (among many others).
 t Access to image layers, alpha channels and paths in Photoshop files.

 t Support for transparency information in Illustrator 
and PDF files.
 t Support for Layer Comps in Photoshop files.
 t Support for Photoshop adjustment layers, text layers, 
layer masks and layers containing effects.

 t Access to transparency of individual layers in 
compatible multi-layered Photoshop files.

Multimedia 
Integration

 t Export to SWF files for Flash Player, support for hyperlinks in PDF files.

 t Export to XFL files for Flash CS4 authoring.
 t Support for interactive PDF files including hyperlinks 
and interactive options, such as buttons and page 
transitions.

 t Interactive authoring and basic animation features 
(for export to SWF files).
 t Support for web-page creation.

Note: this table is a quick overview of some of the key technology differences between InDesign CS4 and QuarkXPress 8. It focuses on unique 
features in each product, not on comparison of core functionality shared by both programs, such as basic text formatting or graphics tools.
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